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Welcome to FormCalc SST for QuickBooks

FormCalc SST Is...

FormCalc SST is a spreadsheet-based calculator for QuickBooks forms—Invoices, Purchase
Orders, Sales Order, or any form where QuickBooks Items are used. FormCalc SST lets you set
up spreadsheet formulas to do calculations involving various fields on the form, then applies those
calculations "on the fly" as it processes the entire form. It can do math involving several columns
at once, produce column subtotals and totals columns, access the form's header and footer
fields, and much more.

"Big deal", you might say, "doesn't QuickBooks already have a calculator?" Well, it does, but the
simple calculator in QuickBooks forms only works within a single field on the form, not between
fields. And it only supports addition, subtraction, multiplication, and division. FormCalc SST lets
you do calculations involving multiple fields, and gives you date math, if-then logic, advanced built-
in spreadsheet functions like COUNT and AVERAGE, and many other sophisticated calculation
and formatting options—just like a full-fledged spreadsheet.

How is FormCalc SST Different from FormCalc (the old / original ver-
sion)?

FormCalc SST is a completely redesigned product. It is based on the general concept of the old
FormCalc for QuickBooks product, but it has the added benefits and greater flexibility offered by
spreadsheet calculation capabilities, a wide range of results formatting possibilities, better file
handling, data file sharing on networks, and more.

Is the old FormCalc still available? Yes! It is still a good choice if your needs are simple—you only
want to add, subtract, multiply, or divide numbers in two columns on an invoice, say, or total a
column or two.

How Does FormCalc SST Work?

Setting up and using FormCalc SST is fairly simple:

1. You may customize your QuickBooks form if desired, adding fields and/or columns to hold
results calculated by FormCalc SST. (Optional; not always necessary.) 
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2. FormCalc SST takes a "snapshot" of the form. It gathers information about the form's lay-
out and builds a spreadsheet representation of it.

3. You enter spreadsheet formulas on the snapshot worksheet to define the calculations you
want done, then save the FormCalc SST file.

4. In QuickBooks you fill out forms as usual, then press a hotkey to invoke FormCalc SST to
do the calculations you have defined. FormCalc SST builds a spreadsheet from the form's
data "on the fly", applies your formulas to it, and writes the results back to the form in Quick-
Books, where you may save it, print it, etc., just as you have always done.

Results calculated by FormCalc SST are saved as part of the form's normal
data. Your accountant or others do not need to have FormCalc SST to see
those results when they view or edit the form.

Specifications & Requirements

FormCalc SST has these computer hardware and software requirements:

· Works with all Microsoft Windows editions of QuickBooks—Simple Start, Pro, Premier, En-
terprise Solutions, etc.— including all international versions:  U.S., Canadian, UK, and Aus-
tralian.

· Works with old QuickBooks versions for Microsoft Windows too, including many which are
not compatible with most QuickBooks add-ons.

· Microsoft Windows XP or a later version of Microsoft Windows.

· 10 mb hard drive space.

· Memory:  any computer with enough memory to run QuickBooks has enough memory for
running FormCalc SST.

This list may change as new FormCalc SST versions are released. An up-to-date list of specifica-
tions and requirements can be found on the  FormCalc SST Downloads page of our Web site.

Copyright and Trademarks

This publication is: Copyright © 1996-2013 Flagship Technologies, Inc. All rights reserved.

FormCalc SST is a trademark of  Flagship Technologies, Inc.

QuickBooks is a trademark of  Intuit.

Revised: 11/15/2017

http://www.goflagship.com/dnloads/sstdownld.htm
http://www.goflagship.com
http://www.intuit.com
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About this Help system
This Help system is designed to be used on-screen. It is extensively cross-linked to help you find what
you need by clicking on a link to jump from any topic to a related topic.

The Basics

Visual Cues

The following type styles and images are used throughout this help system to convey special
meaning:

File > Open Indicates a series of menu selections. (The ">" character separates the in-
dividual menu items to be selected.) This example means to select File

from the main menu, then select Open from its submenu.

Ctrl-R Indicates a key or keys to be pressed. This example means to press the
"R" key while holding down the Ctrl (Control) key.

 Downloads Links preceded by a small "earth" graphic are links to a Web page on the In-
ternet. Clicking on the link will open the page in your Web browser.

c:\Program Files This type style describes a file or folder "path", such as the location of a file
on your hard drive.

Show hints This type style is used when describing text in a window or dialog, either in
FormCalc SST, or QuickBooks, or another program such as a Web
browser.

Getting help while working in FormCalc SST

· To open this Help system while working in FormCalc SST, select Help from the main menu, or
press the F1 key, or click on one of the Help buttons which are available in many pop-up win-
dows.

Getting the printable FormCalc SST User's Guide...it's FREE!

The FormCalc SST User's Guide is a PDF version of this Help system. Unlike on-screen Help,
the PDF file is formatted for printing on your printer, which makes it a much better choice than
printing out individual Help topics. There are two ways to get the file:

· Download it from the FormCalc SST Downloads page on our Web site:

 http://www.goflagship.com/dnloads/sstdownld.htm

· Purchase the Flagship Software CD. For a nominal price, it gets you current installation files for
all our software products, the FormCalc SST User's Guide file, and product videos from our
Web site, all on CD.  It's available from our Online Orders page:

 http://www.goflagship.com/orders/onlineorders.htm

http://www.goflagship.com/dnloads/mpdownld.htm
http://www.goflagship.com/dnloads/mpdownld.htm
http://www.goflagship.com/orders/onlineorders.htm
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Errors and Omissions

This Help system is in an almost continuous state of being updated as FormCalc SST develop-
ment moves forward. Therefore the information and descriptions herein do not necessarily repres-
ent the features or operating characteristics of the current release of FormCalc SST. While the in-
formation is basically correct, it is certain to contain errors and omissions. Some features present
in FormCalc SST may not be described here at all, while other features which are described may
no longer a part of the FormCalc SST product or may not yet be included in it.

If you have any questions or doubts about the accuracy of any information in this document,
please contact us for clarification and/or correction of the information.
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How to get the software ...try it ...and buy it

How to Get the FormCalc SST Software

When you install the FormCalc SST software, it will work in trial mode for up to 30 days for FREE.
To continue using it beyond the trial period, you must purchase a FormCalc SST software license.
Said differently, the "trial mode" version of FormCalc SST is identical to the fully licensed version
—not crippled or limited in any way, except that it will expire in 30 days if you don't purchase a li-
cense to "unlock" the software as the fully licensed product.

If the trial expires before you get a chance to fully try out FormCalc
SST, we can send you a temporary license to extend the trial another 30
days. Just email us at support@goflagship.com and ask for a trial extension.

To get the FormCalc SST installer:

Download it from our Web site

1. Go to the FormCalc SST Downloads page of our site and download the FormCalc SST in-
staller (the actual name of the installer file is sstsetup.exe): 

 http://www.goflagship.com/sst_download.html

2. Run the file you downloaded (sstsetup.exe) to install FormCalc SST on your computer. 

3. Start FormCalc SST.

...and you're on your way!

Please Try FormCalc SST First ...Before Buying a License!

This is important because software license codes are not re-

turnable for refund. You need to be sure you want FormCalc SST before
purchase a license.

Why try FormCalc SST before buying it?

· The 30-day trial is FREE.

· The trial period lets you actually get FormCalc SST fully set up and working in 
your environment—with your version of QuickBooks, your accounting records,
and your computer hardware—before purchasing a software license(s).

· You have full access to our technical support resources during the trial period.

· The trial period lets you be certain you want a FormCalc SST license before pur-
chasing one.

mailto:support@goflagship.com
http://www.goflagship.com/sst_download.html
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How to Buy FormCalc SST

If you followed our recommendation to try FormCalc SST before buying it, you already have
FormCalc SST installed on your computer. If that's the case, there's little left to do to convert the
trial mode installation to the licensed version.

If you don't yet have FormCalc SST installed on your computer see How
to Get the FormCalc SST Software, above, before continuing.

To license your installed copy of FormCalc SST:

1. Purchase a FormCalc SST software license. 

 Go to the FormCalc SST Purchasing page and click on any Buy FormCalc SST button to get
current prices, or to order.

 http://www.goflagship.com/sst_pricing.html

 After you have purchased a license, you will receive a User ID and Registration Code by e-mail.
This code is your unique, personalized "key" for unlocking the FormCalc SST trial version to
use as the full registered version.

2. Enter your Registration Code into FormCalc SST. 

· Start FormCalc SST.

· Select Help > Enter Registration Code... from the main menu, to open the FormCalc SST
Registration window.

· Enter your User ID and Registration Code in the spaces provided.

· Click the Register button to complete the registration process.

See also:

Contacting Flagship Technologies

http://www.goflagship.com/sst_pricing.html
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Getting technical support
Here are ways to get assistance with your questions or problems related to using FormCalc SST*.

1. Consult this Help system (free)

It really does have answers to many of the support questions we are asked. If you don't find the
answer by casually browsing topics, be sure to try the Index and Search tabs!

While working in FormCalc SST you can open the Help system by using the Help item in the main
menu or by pressing the F1 key.

2. Search the FormCalc SST Discussion Forum on our Web Site (free)

We have an online forum dedicated to FormCalc SST support, where you can ask questions, get
answers, and view the questions/answers posted by others. You'll find it here in our list of forums:

 http://www.goflagship.com/forums/

Most likely, your question has already been asked by someone else and answered in the forum.
So the fastest way to get an answer is often to search the forum topics:  click on the Search link,
found toward the top of every forum page.

3. Ask a Question in the Discussion Forums (free)

 http://www.goflagship.com/forums/

If you've searched in the forum and not found the answer you want, then by
all means ask your question there. It's easy:  just click on the New Thread
button, then type your question in the message editor window provided.

You must be registered with the forums and logged in before you can
post a message:

· If you have not yet registered, click on the Register link in the forum
menu, then answer the registration questions. Understand that this just
registers you with the forum; this is not the same as registering your
FormCalc SST software product!

· If you are already registered, you may need to log
in to the forums. Do that by typing your forum
User ID and Password in the box provided above
the forum menu. If you check the box beside Re-
member Me?, the forum software will store a
"cookie" on your computer so you won't have to
log in each time you visit.)

http://www.goflagship.com/forums/
http://www.goflagship.com/forums/
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4. Email Technical Support (free)

If you don't find an answer in the discussion forums, send an email to Flagship Technologies tech-
nical support at: support@goflagship.com. We make an effort to always reply within one business
day and usually reply within a couple hours.

We reserve the right to post your emailed support questions and answers in
our online discussion forums for the information benefit of other users. (We
omit or disguise any of your information which we believe may be confiden-
tial.)

We are glad to answer any of your questions related to general program operation, problem solv-
ing techniques, and program bugs or problems, at no charge. However we cannot provide help
with complex spreadsheet design and setup for free. In those cases we may ask you to purchase
a support incident, described farther below.

5. Telephone and Remote Login Support (fee applies)

Our support by email and Web forums is provided for free. Telephone support and logging into
your computer remotely are both more costly for us to provide, and for that reason we charge a
fee for them. You can get telephone support and/or remote login support as part of a purchased
support incident, as described next.

6. Support Incident (fee applies)

Need help designing and setting up FormCalc SST spreadsheet formulas to do the calculations
you want? Or help with customizing your QuickBooks forms and setting up FormCalc SST to
work with them? These kinds of activities are beyond the scope of what we can provide for free,
but we're glad to do them for you for a fee. Purchasing a support incident gets you our expert as-
sistance with solving a particular QuickBooks form calculation problem using FormCalc SST.  

"What is a 'support incident' ?"

It is a block of our time dedicated to solving your QuickBooks/FormCalc SST design and/or setup
problem. We will work with you by email and telephone to gather information about your Quick-
Books forms and the calculations you want to do, design a solution for you, then work with you to
get it installed and working on your computer—including logging into your computer remotely if ne-
cessary. Support incidents don't have to happen "all at once". They often involve several email or
telephone contacts, carried out over the course of a couple days or more.

You may purchase a support incident on our Web site at:  http://www.goflagship.com/sup-
port.html. 

"How do I get started?"

In all cases, support incidents should begin with an email to support@goflagship.com describing
what you want to do—preferably including a detailed explanation, notes, and screenshots of your
QuickBooks form. We will determine whether what you want done is feasible and, if so, will give
you the go-ahead to purchase a support incident. 

mailto:support@goflagship.com
http://www.goflagship.com/support.html
http://www.goflagship.com/support.html
mailto:support@goflagship.com
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*All prices and support policies are subject to change. See our  Web site for current pri-
cing and policies.

http://www.goflagship.com
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Contacting Flagship Technologies
 
FormCalc SST Web site:  http://www.goflagship.com/sst.html

Postal address:  Flagship Technologies, Inc.
14976 Monroe Rd. 1039
Madison, MO  65263

Web site:  http://www.goflagship.com

Discussion & technical
support forums:  http://www.goflagship.com/forums/

Email addresses: info@goflagship.com  (sales and non-technical questions)
support@goflagship.com  (technical support)

Telephone: 660-291-3000 ...for sales and ordering questions

http://www.goflagship.com/sst.html
http://www.goflagship.com
http://www.goflagship.com/forums/
mailto:info@goflagship.com
mailto:support@goflagship.com
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Windows and Menus
This section provides a quick introduction to the FormCalc SST main window and data windows
(spreadsheet tabs), plus terms which are important in FormCalc SST related to QuickBooks forms.
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About QuickBooks forms and FormCalc SST
Form is a word used often in this Help system as a generic term for "QuickBooks data entry window".
An Invoice is a form...a Sales Receipt is a form...an Estimate is a form...and so on.

FormCalc SST Works With These QuickBooks Forms...

FormCalc SST works with QuickBooks form which (1) use Items and (2) have form customiza-
tion as an option:

Form Areas:  Header, Detail, Footer

All QuickBooks forms basically have three main areas:  (1) Header fields, (2) a Detail (line-items)
area consisting of columns, and (3) Footer fields.
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Form areas described...

Header fields Everything above the Detail (columns) area.

Detail (columns) area The block of columns in the center part of the form, where you may
enter Items and Item-related data (quantity, price, amount, etc.).

Footer fields Everything below the Detail (columns) area.

As you can see below, FormCalc SST's representation of a QuickBooks form has the same three
areas:
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The main window
Here is a quick guide to the FormCalc SST main window.

The FormCalc SST Main Window

Main menu

The main menu gives you access to nearly all program commands.

Main toolbar & buttons

Buttons on the main toolbar give you quick access to program-wide commands, such as
opening or saving a file.

Right-click on the toolbar to customize it.

Editing toolbar

This smaller toolbar gives you access to common editing commands, as shown here:
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Section show/hide buttons

Buttons in this area let you show or hide the Header, Detail, and Footer sections of the
FormCalc SST, as well as anchor rows within the Detail section:

 

Spreadsheet

The main working part of FormCalc SST is a spreadsheet, similar to other spreadsheets like
Microsoft Excel, with columns identified by letters (A, B, C...)  and rows identified by numbers
(1, 2, 3...).

Spreadsheet tabs

Spreadsheet consists of five tabs or pages, described in the Tabs topic.
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Tabs

FormCalc SST Spreadsheet Tabs

FormCalc SST is essentially a spreadsheet connected to some powerful behind-the-scenes software
which controls both the spreadsheet and its interaction with QuickBooks. The spreadsheet consists of
five tabs or "pages", described below.
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QuickBooks tabs and their purposes

Snapshot This is the main tab (page) you will work with in FormCalc SST. It
is where FormCalc SST puts a (spreadsheet-representation) copy of
your QuickBooks form when it takes a snapshot of the form. It is also
where you will enter spreadsheet formulas for performing calculations
when your QuickBooks forms are processed.

Notes This page is for your own use, such as for keeping notes on your cal-
culations, sample formulas, etc. Whatever is on this page is pre-
served when you save the FormCalc SST file, and is never overwritten
(unlike the Snapshot page, which is erased whenever you take a new
snapshot).

Defaults This page contains default data which FormCalc SST uses to create a
new file when you choose File > New.

The Defaults tab is not user editable.

OLD Snapshot When FormCalc SST is preparing to take a snapshot of a QuickBooks
form, it first copies the Snapshot page to the OLD Snapshot page.
This preserves a copy of formulas from the prior snapshot—all of
which are erased by taking a new snapshot—so that you may recover
them by Copying individual formulas to the Windows clipboard from
the OLD Snapshot page, then Pasting them into cells on the Snapshot
page.

Workspace This page is for FormCalc SST's use in processing a QuickBooks
form. It holds the formulas used in the most recent form processing
run. For that reason, it can sometimes be useful to technical support
for debugging purposes.

Changes to the Workspace page do not cause a "File has
changed...Save the file?" prompt to be displayed as you exit FormCalc
SST. So instructions from technical support may specifically ask you
to save the file after a processing run—to be sure the Workspace
page's changes is included—before sending the file to us for analysis
of a problem.
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The Snapshot tab
You will use the Snapshot tab most often. 

After taking a snapshot of the QuickBooks form, it displays three sections corresponding to the
Header, Detail, and Footer sections of the QuickBooks form. 

Header and Footer Sections

Header and Footer sections have the same layout. Here's an example Header section (the Footer
section is basically the same):
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QuickBooks field labels

You can use these cells to label the sample header (or footer) fields brought in from QuickBooks,
after FormCalc SST has taken a snapshot of a QuickBooks form. Labeling field is completely op-
tional, but is especially useful for knowing "which field is which" if any of your formulas refer to
header (or footer) fields.

Header data & formulas

These cells in this column represent the header (or footer) fields of the QuickBooks form for
which the snapshot was taken. They contain data copied from the form during the snapshot.
However, you may enter formulas in these cells, to calculate results which will appear in the cor-
responding header (or footer) fields when you process a QuickBooks form.

Some cells may not have data. These may correspond to empty fields, or to other QuickBooks
controls such as buttons which appear on the form. Some cells may contain strange-looking data;
for instance, dates may be brought into FormCalc SST as numbers like 41653. Don't worry, num-
bers like these are simply the way FormCalc SST (and other spreadsheets) store dates and
times internally.

You can make "date/time" numbers such as these look like dates or times by
formatting them—something you may want to do for easier reading and to re-
mind you that these cells actually hold dates or times, not just numbers.

The topic Dates, times and date calculations gives an overview of date and
time handling.

Detail Section

This is the most important part of the snapshot page for most users. You may enter formulas here
to be applied to each Item row, and you may also enter Item-triggered formulas here—formulas to
be applied only when certain Item names are encountered on forms.
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 Column types

You must indicate the column type of every column in which a formula is to be entered. FormCalc
SST needs this information to properly format calculated results for the QuickBooks columns to
which they will be written. For example, the Quantity and Rate columns accept no more than five
decimal places, so FormCalc SST must limit the number of decimal places in results written to
those columns. 

To indicate the type for a column, right-click in a Column types cell in that column, to display a
pop-up menu, then select the appropriate column type from the menu. 

When you select a column type, if the QuickBooks column labels cell (immedi-
ately below the Column type) is empty, FormCalc SST will fill it with a sample
label for the column.

You must always indicate the Item column, even though no formulas may
be entered there, because FormCalc SST needs to know its location to prop-
erly navigate the QuickBooks form.

 QuickBooks column labels

Just like the field labels in the Header and Footer areas, you can use the cells on this row to label
columns, to make it easier to work with them. Labeling columns is optional, but usually you should
enter labels which match the column names shown in QuickBooks form. (FormCalc SST does
not use the labels for any purpose—they are only for your own information.)

 ### Anchor row for Formulas -->

Every row on which formulas can be entered in the Detail section has one or more anchor rows
available. The screenshot above shows where the anchor row for the Formulas row is located.
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Anchor rows are easier to use than to explain, so we will leave a detailed explanation of them for
later. For now, think of them is being available to allow entering formulas which can refer to the
"prior row" of the QuickBooks form. For example, you can build a formula calculates a running
total on successive rows of the QuickBooks form, by adding an amount from the anchor row to an
amount from the current row.

By the way, anchor rows are all labeled with "###" at the beginning of their name, to make it easy
to distinguish them from other row types.

 Formulas

Immediately after taking a snapshot of a QuickBooks form, this row contains example data
gleaned from the form. But you may overwrite any of that data by entering a formula in place of it.
The columns in which you enter formulas will have their calculated results applied to a Quick-
Books form (Invoice, Estimate, Sales Receipt, etc.) when FormCalc SST processes the form.

For many FormCalc SST users, this is the most-used row of the entire Snapshot page, be-
cause it lets you define formulas which will be applied to every row of a QuickBooks form where
an Item has been entered (with the exception of Item-triggered formula rows, described below).

Cells in which you have entered formulas are highlighted with a yellow back-
ground.

If a formula has an error in it, the cell will be highlighted with a red back-
ground.

 Sandbox

These three rows are meant to give you immediate feedback about formulas you enter on the For-
mulas row.  As soon as you have entered a formula there it is automatically replicated to these
rows, showing how the formula will work when multiple rows of QuickBooks data are processed.

You can change data in any cells on these rows which do not contain formulas, which lets you
play "what-if" with your formulas, to see how they will work with different data values.

These rows have a tan background by default, to remind you that they are only samples.

 Item-triggered formulas

FormCalc SST lets you have up to ten rows containing different sets of formulas which get ap-
plied only when specific Item names are encountered on a QuickBooks form; hence the name
"Item-triggered formulas".

To use these rows, enter formulas on them just as you would on the Formulas row; but addition-
ally, enter an Item name in the column you have designated as the Item column. When a match-
ing Item name is encountered on the QuickBooks form, the formulas associated with the match-
ing Item name on the Snapshot page will be applied to that row of the QuickBooks form. Item
names are matched in either of these two ways:

v Exact match, which occurs when an Item name in FormCalc SST exactly matches an Item
name in QuickBooks (except that differences in capitalization are ignored).
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v Wildcard match, which occurs if you have used wildcard characters in an Item name in
FormCalc SST and a matching Item name is encountered in QuickBooks. FormCalc SST sup-
ports * and ? as wildcard characters:  * matches any number of characters in an Item name,
and ? matches any single character. See the Item-triggered formulas topic for examples.

Item-triggered rows have many important uses; the most common ones being for subtotaling or
totaling columns on a form—to calculate the total shipping weight for an invoice, or the total count
of boxes or pallets shipped, etc.—or to calculate specific taxes or fees at specific locations on a
QuickBooks form. 

Item-triggered rows are also responsible for FormCalc SST's most advanced capability:  the abil-
ity to treat an area of your QuickBooks form as a mini-spreadsheet, which allows doing a variety
of spreadsheet calculations on the form's rows within that area, such as complex tax or manage-
ment-information calculations.

Item-triggered rows are shown in alternating colors to help distinguish them
from each other.

 Scratchpad columns

The Scratchpad is an area on the FormCalc SST Snapshot tab, to the right of the columns which
represent the QuickBooks form's native columns, consisting of ten blank columns colored with a
light yellow background. 

You can enter formulas in the Scratchpad columns which refer to the native QuickBooks
columns, and also, formulas entered in the native columns can refer to cells in the Scratchpad.

The Scratchpad lets you do things like create subtotals and totals of native columns, or do other
intermediate calculations, without adding custom field columns to the QuickBooks form (Invoice,
Sales Receipt, etc.). And because it can reduce the number of columns needed on a QuickBooks
form, in many cased it speeds up processing calculations on the form.

Before the Scratchpad feature was available, calculating the total ship-
ping weight for an Invoice, for example, required adding a blank custom field
column to the Invoice for FormCalc SST's use.
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Steps for Using FormCalc SST
Here are the basic steps involved in using FormCalc SST. For simple calculations you may be able to
follow these steps directly. If your needs are more complex, refer to the More Things to Know and For-
mulas Reference sections for additional details.

If you have questions, or problems with these steps, please contact technical
support at support@goflagship.com.

1. QuickBooks:  Open the form you want to work with

FormCalc SST works with all QuickBooks forms which (1) use Items and (2) have form custom-
ization as an option:

In some cases you may want to customize the form to add fields or columns
for holding additional data or calculated results.

2. QuickBooks:  Enter some data on the form

Fill out the form as you normally would, selecting a Customer or Vendor and entering at least
three Item rows.

Whatever data is on the form will be used as sample data in FormCalc SST.

3. FormCalc SST:  Take a snapshot of the form

Important!

Before taking the snapshot, be sure the QuickBooks form has the Customer Message (or Vendor
Message) field in the footer area of the form. If it doesn't, customize the form so that this field ap-
pears in the form's footer area. FormCalc SST uses this field for navigating the form, so it is abso-
lutely required. 

mailto:support@goflagship.com
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1. Start the FormCalc SST program. 

2. Click the Action button in the main toolbar.

This will cause the focus to switch to QuickBooks, where a Choose an action... pop-up window
will be displayed over QuickBooks. 

3. Click the New Snapshot button in this window, then avoid typing or moving the mouse
while FormCalc SST works.

FormCalc SST will visit each of the form's fields, gathering data about the form, and building a
spreadsheet representation of it on the Snapshot tab in FormCalc SST.

Finally, the focus will switch back to the Snapshot tab in FormCalc SST, where the snapshot
data will be visible.
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4. FormCalc SST:  Assign column types

Right-click cells on the Column types row in the Detail section, and choose a column type appro-
priate for each column. You must at least choose a type for the Item column and for any column
where you will enter formulas.
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You may also want to enter field labels for some or all fields, to match the
field names in QuickBooks. Doing that can reduce confusion as you work with
fields and enter formulas.

5. FormCalc SST:  Enter spreadsheet formulas

Formulas you enter in FormCalc SST will be used to calculate results when processing your
QuickBooks forms later. You can enter formulas in the cells shown here:
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Here's an example formula:

=SUM(E19,B7:B9)

Things to know:

= All formulas begin with an equal sign. This is what distinguishes
formula cells from cells containing text and data.

SUM() Formulas often include one or more built-in function such as SUM(),
which sums whatever is between its parentheses. For a full list of op-
erators and functions, see the Formulas reference section.

E19 This is a reference to a single cell, E19.

B7:B9 This is a reference to a range of cells, from B7 through B9. A range
reference consists of two cell references separated by a colon (:)
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Which cells can formulas refer to?

Header formu-
las

Can refer to other Header cells and to Footer cells.

Formulas row
formulas
(in the Detail
area)

Can refer to Header cells, Footer cells, other cells on the Formu-
las row, and cells on the Formulas row's anchor row.

Item-triggered
formulas
(in the Detail
area)

Can refer to Header cells, Footer cells, other cells on the same
Item-triggered formula row (i.e., not to cells on other Item-
triggered rows), and to cells on the Item-triggered row's anchor
rows. (Item-triggered rows have several anchor rows, to support
the mini-spreadsheet feature.)

Footer formu-
las

Can refer to other Footer cells and to Header cells.

See the Formulas and cell references section for more details about formulas.

6. FormCalc SST:  Format the results

If the format of calculated results in a formula cell doesn't match what you want to see in Quick-
Books, right-click it and choose Format from the pop-up menu.

This will open the Format data or results window, where you can choose the formatting options
you want.
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See the Formatting data and calculated results topic for more details.

7. FormCalc SST:  Save the file often!

Don't forget to save your FormCalc SST file as you're working on it, so you don't lose any of your
formulas or other changes. You can use the Save button in the main toolbar:

8. QuickBooks:  Test your FormCalc SST setup

1. In QuickBooks, open or click on the form you want to process, if you are not already work-
ing in that form. 

2. Press the FormCalc SST hotkey—the F11 key unless you have changed it in Preferences.

The Choose an action... window will pop up over QuickBooks.
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3. Click the Process this QuickBooks form button...or press the hotkey a second time.

Pressing the hotkey a second time is quicker for most users.

FormCalc SST will visit the form's fields, gathering data for calculations and inserting calcu-
lated results in the fields and columns corresponding to the cells where you entered formulas.

If the results were not what you intend, change or adjust formulas and formatting in FormCalc
SST, then try processing the form again.

The Revert button found on most QuickBooks forms is handy for returning
the form to its original state, prior to FormCalc SST's calculations.

If you change the layout of your QuickBooks form—change column or field
order, or add or remove columns or fields—then you'll have to take a new
snapshot. (You can retrieve formulas from the prior snapshot by Copying
them from the OLD Snapshot tab and Pasting them into the appropriate cells
in the Snapshot tab.

9. Use your FormCalc SST setup for data entry!

Once you have a FormCalc SST file set up for a particular QuickBooks form, the work is done. All
that's left to do is use it!

Using FormCalc SST to process forms adds just one step to your data entry cycle. Instead of: 
enter data on a form, save the form...and repeat, your data entry cycle will be: enter data on a
form, invoke FormCalc SST to do calculations, save the form...and repeat.

Most users have only one FormCalc SST file, for working with a single QuickBooks form such as
an Invoice. FormCalc SST loads the most recently used file when it starts up, so having the cor-
rect file loaded is automatic in most cases. 
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However, you may have several files, for working with different forms...or for working with several
different customers' forms if you provide bookkeeping services to others. In those cases, be sure
you have the correct FormCalc SST file loaded before processing forms.
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Problem Solved! How-To Examples
This section contains step-by-step examples of using FormCalc SST to solve different kinds of calcu-
lation problems, to help you apply FormCalc SST's wide range of flexible calculation abilities to your
own QuickBooks forms.

Want even more examples?  Our Web site often has new examples you won't find here, because it
may be updated at any time while this Help system is only updated when a new FormCalc SST ver-
sion is released. For the most complete set of FormCalc SST examples, go to Problem Solved!™
page on our Web site:

 http://www.goflagship.com/sst_probsolv.html

http://www.goflagship.com/sst_probsolv.html
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Customizing QuickBooks forms (adding fields)
This example demonstrates:

· How to add fields to a QuickBooks form

Adding Fields to a QuickBooks Form

Often you may need to add fields to a QuickBooks form to hold data used by FormCalc SST for-
mulas, or to hold results calculated by FormCalc SST. The details of customizing different forms
differs slightly, but overall the process follows these steps:

1. Open the form you want to customize. 

In this example, we will work with the Invoice form (Customers > Create Invoices).

2. Click on the form's customize command.

In QuickBooks 2014 you'll find the command in the form's menu/ribbon bar (Formatting > Cus-

tomize Data Layout):

In older versions, the customize command or button may be in a different location, such as:

The Additional Customization window will open. Notice the Header, Columns, and Footer tabs.
These are the main tabs you'll be interested in to customize the form for use with FormCalc
SST.
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Header
tab

Lets you control which fields appear in the form's header, including custom
fields defined in the Customer or Vendor list (depending on whether the form is
Customer-oriented or Vendor-oriented).

Columns
tab

Lets you control which columns appear in the form's detail area, including cus-
tom fields defined in the Item list.

Footer tab Lets you control which fields appear in the form's footer, including custom
fields defined in the Customer or Vendor list (depending on whether the form is
Customer-oriented or Vendor-oriented).

3. Click on the tab you want to work with (Header, Columns, or Footer).

4. Select fields to include by check marking their boxes in the Screen column.
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The Other 1 and Other 2 fields are spare fields you can use for nearly any
purpose. They are handy for holding data or calculation results when working
with FormCalc SST on a QuickBooks form, but their contents are not available
on QuickBooks reports! So when calculating something that you may want to
see on a report, use custom fields instead.

FormCalc SST requirement: The form must have the Message field enabled
on the Footer tab! (See the instructions below.)

The Screen column controls which fields/columns appears in the form's window in Quick-
Books, while the Print column controls which appear on printed copies of the form. Often you
may have fields/columns you want to include in the form's window (Screen) but which do not
want to include on copies printed for your customers (Print).

5. You may change the order of fields (in the Columns tab only) by changing column numbers

in the Order column.

For instance, if a column is at position 5 and you want it at position 3, change its number from 5
to 3. The other columns will be automatically renumbered to accommodate the change.

6. You may rename fields by entering new names in the Title column.

7. Click OK to close the Additional Customization window.
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How do I get custom fields to show on my forms?

Custom fields—the fields you can define in the Item, Customer, and Vendor lists—can also ap-
pear on QuickBooks forms. However, you have to define custom fields before they are available to
include during the form customization steps described above.

See Defining and using custom fields for details.

You MUST Include the Customer (or Vendor) Message Field!

FormCalc SST places only one requirement on your QuickBooks forms: they must have a Cus-
tomer Message (or Vendor Message) field. FormCalc SST uses that field for form navigation.

So when customizing forms, be sure to include the Message field on the Footer tab, as shown

below, by checkmarking the box in the Screen column. Checkmarking the Print column box,
which causes fields to show on printed copies, is optional.
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Defining and using custom fields
This example demonstrates:

· Why you may want to use custom fields

· How to add custom fields to a Customer, Vendor, or Item list

· How to populate custom fields with data

Why Use Custom Fields?

Defining custom fields in QuickBooks lists (the Item list, Customer list, or Vendor list) has at least
two benefits:

1. They make more fields available on your forms (via form customization)—more places for
holding data and calculated results. 

2. They let you individualize forms for each Item, Customer, or Vendor. Data specific to an
Item, Customer, or Vendor is automatically pulled into custom fields on a form when you select
from those lists, and that data can be used in FormCalc SST formulas to customize the form's
text, messages, or calculated results.

Adding Custom Fields to a List

Item list

1. Open the Item list by choosing Lists > Item list from the QuickBooks main menu. 

2. Select an Item to edit and open the Edit Item window.

To do this, click on the Item you want to edit, then choose Edit Item from the Item button's
menu at the bottom of the Item list window.
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The Edit Item window will open.

3. Click on the Custom Fields button.

The Custom fields dialog will open.
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4. Click on the Define Fields button.

The Set up Custom Fields for Items dialog will open.

5. Add one or more custom field names to the list.

Custom fields you add here are added to all Items, not just the one you
are currently editing.

6. Click OK to close the dialog.

Customers or Vendors

The steps for defining custom fields in the Customers list and Vendors list are the same. Here are
steps for the Customers list.

1. Open the Customer Center by selecting Customers > Customer Center from the QuickBooks
main menu. 

2. Edit a customer by right-clicking on a customer name in the left pane, then selecting Edit
Customer:Job from the pop-up menu.
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The Edit Customer window will open.

3. Click on the Additional Info tab of the Edit Customer window.

4. On the Additional Info tab, click on the Define Fields button.
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The Set up Custom Fields for Names window will open.

5. Add one or more custom field names to the list.

Custom fields you add here are added to all Customers, not just the one
you are currently editing.
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6. Click OK to close the dialog.f

Populating Custom Fields (Adding Data)

To be useful for calculations on QuickBooks forms, custom fields need to contain data.

Here are the steps for adding data to custom fields in the Items list. (The steps are basically
identical if you are working with the Customer list or Vendor list.)

1. Open the Item list. 

Choose Lists > Item list from the QuickBooks main menu.

2. Select an Item to edit and open the Edit Item window.

To do this, click on the Item you want to edit, then choose Edit Item from the Item button's
menu at the bottom of the Item list window.

The Edit Item window will open.
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3. Click on the Custom Fields button.

The Custom fields dialog will open.

4. Enter data for any or all of the custom fields, as appropriate for the Item.
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5. Click OK to close the Custom fields dialog.

6. Repeat these steps for all Items which need data in their custom fields.

Including Custom Fields in a Form

After defining a custom field and populating it with data, you still have to include it in a QuickBooks
form to make the data available to FormCalc SST formulas. To do that, follow the steps in Cus-
tomizing QuickBooks forms for FormCalc SST.

Notes:

· Customer list and Vendor list custom fields can only be included in the form's header. (They are
available on the Header tab of the Additional Customization window.)

· Item list custom fields can only be included in the form's Detail (columns) area. (They are avail-
able on the Columns tab of the Additional Customization window.)

Any time you change a QuickBooks form's layout you will need to take
a new snapshot of the form, so that FormCalc SST's Snapshot page
matches the new layout.
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FormCalc SST makes custom fields more useful!

With QuickBooks alone, custom fields mostly hold descriptive information. If you
had Items representing shoe inventories, custom fields might hold shoe color,
style code, or sales category (dress, casual, running, etc.) for display on invoices
and purchase orders.

But with FormCalc SST custom fields can hold data, not just information. When
you select a Customer, Vendor, or Item on a form, custom fields on the form can
automatically pull in Customer-, Vendor-, or Item-specific data which FormCalc
SST can use to customize the form's text, messages, or calculated results.

List type Custom Field Benefits

Item Shipping
Weight

As you select each Item on an Invoice, its per-Item shipping
weight can be pulled into the form. FormCalc SST can multiply
each Item's weight by the quantity invoiced, and can calcu-
late a total shipping weight for the invoice.

Width
Height
Length

Where lumber sales are priced per board foot, Items identify-
ing lumber inventory (such as a 2"x4", 8' long) could include
each lumber dimension in several custom fields. FormCalc SST
could multiply those fields together and convert inch dimen-
sions to feet, to calculate board feet, then multiply by the
number of units purchased to to put the total number of
board feet in the form's Quantity column.

Count per Pal-
let

When Items have a known full-palette quantity, that quantity
could be entered in a custom field of the Items list and
FormCalc SST could use it to calculate the number of palettes
to ship for a given ordered quantity.

Customer Shipping Re-
gion

You could store a region/location code in a custom field of
the Customers list, and use it to adjust freight or shipping
charges.

Cust. Code You could store a customer discount code or percentage in a
custom field of the Customers list, and  FormCalc SST could
use that code or percentage to calculate customer-specific
discounts on invoices.
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Calculating a running total
This example demonstrates:

· How to add a blank column to a QuickBooks form

· How to calculate a running total in that column

· Using anchor rows in FormCalc SST formulas

How to Calculate a Running Total

EverStone Products sells decorative and architectural stone throughout the Midwest. Most is
shipped on pallets on the company's own trucks. The office staff has customized the Packing Slip
template for QuickBooks' invoices to serve as a Bill of Lading. They apply the customized tem-
plate to completed invoices, then print off the Bills of Lading to send down to the crew in the load-
out yard.

When loading a truck it would be useful to have a running count of the pallets to be loaded, to help
verify the palette count of each product as loading proceeds. EverStone's manager would like a
running total column added to the Bill of Lading.

Customizing the Bill of Lading (Packing Slip) template

Add a column to the Bill of Lading template to hold the running total.

1. Open the Invoice form. 

2. Apply the Bill of Lading (or Packing Slip) template to the Invoice if it isn't applied already, by
selecting it in the Template field.

3. Click on Formatting > Customize Data Layout in the form's menu/ribbon bar.
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The Additional Customization window will open.

4. Click on the Columns tab.

We need an unused field we can add to the form to hold the running total. Other 1 and Other 2
are spare fields available for any purpose, so let's use Other 1.

5. On the Other 1 line, checkmark the box in the Screen column, change the field's title to

Run.Total, and enter 4 in the Order column, which will place the field just to the right of the

Quantity column, which is column 3.
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Be sure the Message field is selected on the Footer tab, also, even if

you don't need it. The Message field is required by FormCalc SST.

6. Click OK to close the Additional Customization window.

Here's how the modified Bill of Lading template should look when applied to an Invoice. Notice
the Run.Total field:
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For more customization details, see Customizing QuickBooks forms for
FormCalc SST.

Taking a snapshot and setting up the formula

Next, FormCalc SST needs to take a snapshot of the Invoice with the Bill of Lading template ap-
plied.

1. In FormCalc SST, choose File > New from the main menu to begin a new file. 

This step is not required, but it assures you won't overwrite an existing FormCalc SST file.

2. Click the Action button in the main toolbar.

The focus will switch to QuickBooks, and the Choose an action dialog will appear:
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3. Click on the New Snapshot button.

FormCalc SST will take a few seconds to gather information about the form, then display a rep-
resentation of the form on the Snapshot tab.

4. Indicate the column type of the Item column and of the Run.Total column, at least.

You must always indicate which is the Item column. Beyond that, you must identify the column
type for all column which will have formulas—in this case, just the Run.Total column. 

Here's a partial view of the snapshot with column types of the Item column and a couple others
already selected, and the Run.Total column's pop-up (right-click) menu displayed on the
Column types row—Run.Total's column type is about to be selected as Other.
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5. Display the Formulas row's anchor row by clicking on the [ A ] button on the toolbar and se-
lecting Formulas anchor row.

The anchor row should now be visible immediately above the Formulas row:

6. Enter the formula for the running total in the Run.Total column.
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The formula is pretty simple:    =F16+G15

It adds the value in the Quantity column on the current row (F16), to the value of the Run.Total
column from the prior row—represented by a reference to the anchor row cell G15. (When
FormCalc SST actually processes QuickBooks forms, it will copy this formula for each row of
data on the form.)

Formula references to an anchor row are always relative, meaning they
always refer to the "prior" row of QuickBooks form data.

7. Click on the Save As button and supply a filename, to save the FormCalc SST file.

FormCalc SST files are identifiable by their .SSF filename extension (.SST in
prior versions).

FormCalc SST is now ready to use for calculating running totals on the Bill of Lading template.

Processing QuickBooks forms

To process an Invoice in QuickBooks:

1. Be sure the Bill of Lading template is applied to the Invoice. 

The FormCalc SST file is specific to the layout of that template.

2. Press the FormCalc SST hotkey, which is F11 unless you have changed it in Preferences.

The Choose an action dialog will appear:
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3. Process the form by either (1) pressing the hotkey a second time, or (2) clicking on the Pro-

cess the QuickBooks form button.

Here's a view of the form after processing. The numbers in the Run.Total column were calcu-
lated by FormCalc SST.
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Totaling and subtotaling columns
This example demonstrates:

· How to set up a trigger Item in the QuickBooks Item list

· How to total a column

· How to subtotal a column

How to Total a Column

Totaling columns is a common need, and the most common use for Item-triggered formulas.
Item-triggered formulas are those which FormCalc SST applies only when a specific Item name is
encountered—the Item name you have entered on the Item-triggered formula's row in FormCalc
SST.

Items which "trigger" Item-triggered formulas are often referred to as trigger
Items.

Totaling a column with FormCalc SST involves (1) setting up a trigger Item in QuickBooks, (2) us-
ing that Item name on QuickBooks forms where you want the total to appear, and (3) associating
the Item name with an Item-triggered formula row which calculates the total.

Setting up a trigger Item

Trigger Items are usually QuickBooks Items you have set up specifically for the purpose of trigger-
ing FormCalc SST calculations.

This isn't always true. See Tips for Trigger Items in the Item-triggered formu-
las topic.

For this example we will set up a Service-type Item named Total.

1. Open the Item list by choosing Lists > Item list from the QuickBooks main menu. 

2. Choose New from the Item button's menu at the bottom of the Item list window.
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The New Item window will open.

3. Fill the New Item window's fields as shown here.

Notes:

· The Item name and Description can be anything you want.

· The Account this Item posts to is an equity-type account set up specifically for working with
FormCalc SST trigger Items, called FormCalc Item Posting. We could have posted to an in-
come or expense account, but using an equity account dedicated to this purpose makes
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spotting errors easier (unintentionally posting income or expense, etc.). For an explanation,
see Tips for Trigger Items in the Item-triggered formulas topic.

Using the trigger Item on QuickBooks forms

The location of the Total Item will determine where FormCalc SST calculates a total. Generally
you will want to enter it as the last line in the form's Detail section, like this:

The total won't be calculated, of course, until FormCalc SST processes the form.

Setting up formulas in FormCalc SST

1. Take a snapshot of the QuickBooks form. 

Taking a snapshot of the form is always necessary before setting up formulas. Because taking
snapshots is described in several earlier sections, the details won't be shown again here.

2. Choose a column type for each column in the snapshot by right-clicking in each column on
the Column types row, then selecting the column type from the pop-up menu, as shown here
for the Amount column:
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3. Enter a formula to total the desired column.

The formula must be entered on one of the Item-triggered formulas rows—let's use the Item-
triggered formulas 1 row. For this simple example our formula will total the Quantity column,
but you can total any numeric column in the Detail section of a form. 

Enter the following formula in the Quantity column on the Item-triggered formulas 1 row (cell
F36 in this example):

=SUM(F1:F1)

"Wait a minute! This formula appears to sum cell F1. Is that really what
will happen?" No. When entering formulas you can refer to the whole column
of data without using exact cell coordinates. FormCalc SST will adjust your
formula to the required coordinates immediately after you've entered it, as
described below. (For details, see "Close enough" cell referencing in the For-
mulas and cell references topic.)

FormCalc SST will convert the formula to:

=SUM(F28:F30)

(Cell range references to the first and last row of the Sample formulas and data area—the
rows with tan backgrounds in the screenshot above—tell FormCalc SST to reference "the
whole column of data" when processing a QuickBooks form.)

4. Enter the trigger Item's name (Total, in this case) in the Item column of the same Item-

triggered formulas row where you entered the formula.

The item name is what will connect the formula with a particular row of data on your Quick-
Books forms.

Here's a view of the Item-triggered formulas 1 row with the formula and item name in place:
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5. Click on the Save button to save the file.

FormCalc SST files are identifiable by their .SST filename extension (.SST in
prior versions).

FormCalc SST is now set up for calculating totals on QuickBooks forms, wherever the Total
Item appears.

Processing QuickBooks invoices

To process an Invoice in QuickBooks:

1. Switch to QuickBooks, and open or click on the Invoice you want to process. 

2. Press the FormCalc SST hotkey, which is F11 unless you have changed it in Preferences.

The Choose an action dialog will appear:
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3. Process the form by either (1) pressing the hotkey a second time, or (2) clicking on the Pro-

cess the QuickBooks form button.

Here's a view of the Invoice after processing, showing the total calculated by FormCalc SST.

How to Subtotal Columns

The simplest way to subtotal columns on QuickBooks forms is to use the same trigger Item name
in several places on the form. Let's prove this by making minor changes to the Item name and
FormCalc SST setup, then processing an Invoice.
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You can also calculate subtotals using different Item names. That ap-
proach may be necessary when additional calculations are needed on the
subtotal rows, and those calculations need to be different for each Item. This
is a more advanced approach: the rows included in each subtotal may have
to be controlled by using IF() functions in the formulas.

Changing the Item name

The Total Item we set up earlier would work for subtotals too, as is. But having the word "Total"
appear on several rows of an Invoice might be confusing to someone else looking at the Invoice.
So let's change the Item name to Subtotal:

1. Open the Item list by choosing Lists > Item list from the QuickBooks main menu. 

2. Select the Total item by clicking on it.

3. Choose Edit Item from the Item button's menu at the bottom of the Item list window.
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The Edit Item window will open.

4. Change the Item's Name and Description from Total to Subtotal:

5. Click OK to close the window.

Updating the FormCalc SST file

We have not changed the layout of the QuickBooks Invoice, so we don't need to take a new snap-
shot. We only need to update the Item-triggered formulas 1 row with the Item's new name, Sub-
total. 

Everything else stays the same. We don't need to change the formula, because of how
FormCalc SST handles repeat occurrences of trigger Items. During form processing, each
time an Item name appears FormCalc SST checks to see if there was a prior occurrence of it.
If so, the formula is adjusted to include only data rows since the most recent prior occurrence
of the Item name.
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Processing QuickBooks forms...with subtotals

The steps for processing forms is the same as describe above. We've added more data rows to
the example Invoice, to better demonstrate how subtotals work.

Before processing:

After processing with FormCalc SST (note the subtotals):
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Shipping weight calculations
This example demonstrates:

· How to set up trigger Items in the QuickBooks Item list

· How to calculate a column from two other columns

· How to total a column

Overview

If you define a custom field in the Item list and you store the per-unit shipping weight there for each
Item, then when you select an Item on an Invoice or other form QuickBooks can automatically
bring the shipping weight into the form on that line.

With the shipping weight available on each line, FormCalc SST can multiply it by the quantity to
calculate an extended shipping weight on each Item line (Quantity * Ship Wt = Extd Wt).
FormCalc SST can also total the extended shipping weight column, to calculate a total shipping
weight for the form (Invoice, etc.).

How to Calculate Per-Item and Total Shipping Weights

QuickBooks Setup

1. Define a custom field named Ship Wt in the Items list: 

2. Enter a shipping weight for each Item—or at least, for those Items you ship: 

3. Add an Item to the Items list, to use as a trigger Item.
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You will use this Item on QuickBooks forms to control where the extended weight column's total
appears. Make it a Service-type Item and name it TotalShipWt. 

The FormCalc Item Postings account has been assigned to this Item, as dis-
cussed in the Tips for Trigger Items topic, but you may use an income or ex-
pense account if you wish.

4. Customize the form where the shipping weights will be calculated.

On the Columns tab, include the Ship Wt custom field. Also include the Other 1 field, and re-
name it Extd Wt. 
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Also, renumber the Order column if necessary, to order fields as you want them:

5. Finally, fill out the form as you normally would, so it contains some sample data for

FormCalc SST to copy when taking a snapshot of the form. The Extd Wt column is empty of
course—it hasn't been calculated yet.
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FormCalc SST Setup

1. Select File > New from the main menu to start a new FormCalc SST file. 

(Optional. You may overwrite the existing file if you want.) 

2. Take a snapshot of the QuickBooks form.

FormCalc SST will gather data about the form and build a spreadsheet based on it.

3. Assign column types on the Column types row, identifying the spreadsheet's column types
with the corresponding QuickBooks columns. 

The column types row should look something like the following, depending on the order and
number of columns on the QuickBooks form:

4. Enter a formula in the ExtdWt column of the Formulas row, which multiplies the Quantity

column by the ShipWt column.

For example:

=F18*H18 ...your formula will be different if your form has a different
column layout.)
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5. Enter a formula in the ExtdWt column of the Item-triggered formulas 1 row, to total the entire

ExtdWt column.

When referring to a whole column in a formula, you can simply referring to a one-cell "range" of
the column:

=SUM(I1:I1) ...again, your formula may be different

FormCalc SST will adjust this one-cell range to the correct coordinates for summing the entire
column, I24:I26 (see the "Close enough" cell referencing topic for details):

6. Also enter the trigger Item name, TotalShipWt, in the Item column of the same row, as
shown above.

7. Save the file to assure your changes are kept.

FormCalc SST files are identifiable by their .SST filename extension (.SST in
prior versions).

Processing a QuickBooks Form

To verify that your FormCalc SST setup works as desired, just process a QuickBooks form con-
taining some data.

From FormCalc SST

1. Press the Action button in the main toolbar. 
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The focus will switch to QuickBooks, and the Choose an action dialog will appear:

2. Click on the Process this QuickBooks form button to process the form. (See example res-
ults below.)

From QuickBook

1. Press the FormCalc SST hotkey, which is F11 unless you have changed it in Preferences. 

The same Choose an action dialog as shown above will appear.

2. Process the form by either pressing the hotkey a second time (quickest for most users), or

clicking on the Process the QuickBooks form button.

Results

After processing, the form should look something like this. As you can see, the correct extended
weight has been calculated on each line and a total shipping weight has been calculated at the
bottom.
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Note:  When you save a QuickBooks form, the FormCalc SST-calculated
results are saved with it. Other QuickBooks users who view the form will be
able to see the calculated results even if they don't have FormCalc SST on
their computer.

If  you don't want to have the EXTD WT column on the Invoice, another option is to omit that column

when customizing the form, and use one of the Scratchpad columns for the extended weight calculation in-

stead.

Using your FormCalc SST setup

Once you have tested your FormCalc SST setup, it is ready to use for day-to-day data entry work.
With the QuickBooks and FormCalc SST programs both running, most of the time you will (1) fill
out a form, (2) invoke FormCalc SST from within QuickBooks by pressing the hotkey, (3) save the
form, and (4) repeat.

Related topics:

Totaling or subtotaling a column
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Customer discount message, part 1
This example demonstrates:

· Using text functions to build a customer message containing a discount amount

· Using text functions to include a discount deadline based on the Invoice date, in the cus-
tomer message

· Referencing a header field (Invoice date) in formulas

· Using trigger Items to control where calculations occur

Part 2 extends this example, adding an "indicator column" to limit the dis-
count to specific Items on the form

How to Build a Custom Message Based on the Invoice Date

Overview

Skyview Farm Service supplies agricultural chemicals, fertilizer, and other crop production sup-
plies to farmers in the surrounding area. The amount they borrow on an operating credit line at the
bank grows incredibly large during the busy part of the cropping season. During that time their
sales volume is high, the products they sell are expensive, and Accounts Receivable collections
are particularly slow—partly because their  customers (farmers) are very busy then too. Fertilizer,
especially, puts a big burden on their borrowing needs. Skyview often carries a balance of up to
$250,000 in Accounts Receivable for fertilizer alone in the busiest months.

To reduce the lofty amounts of operating credit they need, manager Jerry Swartz has decided to
try to improve cash flow by offering a 2% discount on all invoices paid within 10 days, during the
busy months of April, May, and June.

But Jerry managed another farm supply business in the past and, in his opinion, only putting the
discount terms at the top of the invoice—as "2% 10 net 30"—is not very effective. Many custom-
ers fail to take advantage of the discount, because the deadline date is unclear and the amount
they could save by paying early is not very apparent. So Jerry wants Skyview's invoices to have a
message at the bottom which clearly spells out the discount amount and deadline date, some-
thing like this:

*** DISCOUNT of $123.45 if paid by 11/14/2013 ***

This is something you can do for Jerry, with FormCalc SST.

QuickBooks Setup

1. Add an Item to the Items list, to use as a trigger Item. 

The placement of this Item on invoices will determine where FormCalc SST displays the dis-
count message. Give the Item a name which reminds you of its purpose, such as CMsg (for
customer message). You can leave the Description field empty, because FormCalc SST will
supply that during form processing.
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2. Open the Invoice form, and fill it out as you normally would.

Select a Customer, and put at least three Item lines on the form as sample data for FormCalc
SST to copy when taking a snapshot of the form. In this example we've included the CMsg Item
just to illustrate where it will go in the Invoice, though we didn't really need to include it for taking
the snapshot.
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FormCalc SST Setup

1. Select File > New from the main menu to start a new FormCalc SST file. 

(Optional. You may overwrite the existing file if you want.) 

2. Take a snapshot of the QuickBooks form.

FormCalc SST will gather data about the form and build a spreadsheet based on it.

3. Assign column types on the Column types row, to identify the spreadsheet's column types
with their corresponding QuickBooks columns. 

The column types row should look something like this:

4. In the Header section, find and label the Date (invoice date) field.

The reason for finding and labeling the Date field is to be sure you've identified the correct field
before entering a formula which refers to it. (Labeling the field is optional but can prevent mak-
ing mistakes later.) 

The Date field's contents probably won't be what you expect. As you can see
below, dates come into FormCalc SST expressed as numbers. This may be
confusing at first, but it is what is what allows spreadsheets to use dates in
calculations. (In the next step you will format the number as a date.)

5. Format the Date field's cell as a date.
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Right-click on it (the cell containing the number, not the "Date" label), then select Format from
the pop-up menu. The Format data or results window will open, where you can select a date
format as shown here.

When you are done the date cell should be formatted to look like this:

6. On the Item-triggered formulas 1 row, enter the trigger item's name in the Item column,
and this formula in the Description column:

="*** DISCOUNT of "&DOLLAR(SUM(H24:H26)*0.02,2)&" if paid by:
"&TEXTD(B6+10)&" ***"

This screenshot shows the formula, calculated results, and trigger item as entered on the
snapshot sheet.
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Here's the formula again.

="*** DISCOUNT of "&DOLLAR(SUM(H24:H26)*0.02,2)&" if paid by:
"&TEXTD(B6+10)&" ***"

Let's break it down to see how it works:

= Every formula begins with an equal sign (=).

"*** DISCOUNT
of "

The first part of the text we want on the line.

& Joins two text strings together

DOLLAR( ) The Dollar() function formats a number as currency, using the number of
decimal places you specify.

SUM(H24:H26) The SUM() function sums a range of cells. SUM(H24:H26) refers to the entire

range of sample rows in the Amount column, which is "shorthand" that tells
FormCalc SST to sum the entire column when a QuickBooks form is actu-
ally being processed.
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*0.02 Multiplies the SUM(H24:H26) result by 0.02 to calculate the 2% discount
Skyview  will be offering.

,2 Tells the Dollar() function how many decimal places to use.

& Joins two text strings.

" if paid by: "More text we want on the line

& Joins two text strings.

TEXTD(B6+10) Takes the date/time value from cell B6 (the Invoice date field from the form's
header), adds 10 days to it, and formats the result as a text string date.

&" ***" Joins the last piece of text to the line.

7. Save the file to assure your changes are kept.

FormCalc SST files are identifiable by their .SST filename extension (.SST in
prior versions).

Processing a QuickBooks Form

To verify that your FormCalc SST setup works as desired, process a QuickBooks form containing
some data.

From FormCalc SST

1. Press the Action button in the main toolbar. 

The focus will switch to QuickBooks, and the Choose an action dialog will appear:
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2. Click on the Process this QuickBooks form button to process the form. (See example res-
ults below.)

From QuickBooks

1. Press the FormCalc SST hotkey, which is F11 unless you have changed it in Preferences. 

The same Choose an action dialog as shown above will appear.

2. Process the form by either pressing the hotkey a second time (quickest for most users), or

clicking on the Process the QuickBooks form button.

Results

The form should look something like the following after it has been processed. Compare the in-
voice date with the message date, and you'll see that the message is 10 days later. Also, the dis-
count amount has been calculated correctly as 2% of the Amount column.

If the dates below seem odd it's because the example is based on one of
QuickBooks' sample company files, where all dates are future dates.
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When you save a QuickBooks form, the FormCalc SST-calculated results
are saved with it. Other QuickBooks users who view the form will be able to
see the calculated results even if they don't have FormCalc SST on their
computer.

But then Jerry says, "Wait a minute..."

"I only want the discount to apply to the fertilizer Items, not to everything on the Invoice."

You think "Well then why didn't you mention that?" but you say "No problem...it'll just take a bit
more setup work." You will need to add a custom field to the Items list, add a couple columns to
the Invoice, and make some formula changes...all of which are described in Part 2 of this ex-
ample.

Related topics:

Totaling or subtotaling a column
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Customer discount message, part 2:  using an
"indicator" column

This example demonstrates:

· Using an "indicator column" to control calculations

· Using text functions to include a discount amount and deadline date in a customer mes-
sage

· Referencing a header field (Invoice date) in formulas

· Using trigger Items to control where calculations occur

This is a continuation from Part 1. Refer to Part 1 for a background on the

reasons why Jerry Swartz, manager of Skyview Farm Service, wants an "avail-
able discount" customer message on the company's invoices.

Limiting the Discount to Specific Items

Overview

continued from Part 1...

We've learned that Jerry, the manager at Skyview Farm Service, now wants the available discount
to apply only to specific Item lines on the Invoice—only to Items representing fertilizer products.
Adding that capability will require a few simple steps. You will need to:

· Add a custom field to the Items list to indicate which Items are discountable, and include that
field on Skyview's Invoices. We'll call that field an "indicator column", because of the job it does.

· Add another column to Skyview's Invoices for holding the dollar amount of discountable Items.
It will contain the results of a formula which multiplies the indicator column by the Amount
column.

· Take a new snapshot of the Invoice with FormCalc SST, because the Invoice layout has
changed.

· Add formulas to the snapshot. They will be only slightly different from those in Part 1.

The result will be a customer message at the bottom of invoices, which displays an available dis-
count amount and the discount deadline date, like this:

*** DISCOUNT of $123.45 if paid by 11/14/2013 ***

QuickBooks Setup

Adding a custom field in the Items list, and storing data in it

Only the main steps are shown here. For more detail see the Defining and us-
ing custom fields topic.
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1. Define a new a custom field in the Items list, and name it Discountable. 

2. Edit each of the fertilizer Items in the Items list, and enter a "1" in the Discountable
field (in the Custom Fields window).

Only do this for discountable Items; in this case, fertilizer Items.

Why not use an "x" or some other character? Because using a "1" will
keep the FormCalc SST formulas simple.

Adding columns to the Invoice

1. Click on the command to customize the Invoice form's layout. 
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The Additional Customization window will open.

2. On the Columns tab of the Additional Customization window, checkmark boxes in the Screen

column for the Discountable field, and the Other 1 field.

· Discountable is the custom field added in the steps above.

· Other 1 and Other 2 are spare fields you may use for any purpose. In this case you will
use one of them (either will do) to hold calculated results from a FormCalc SST formula.

3. You can also change the fields' display names if you want, in the Title column, and

change their order by renumbering the Order column.
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In the screenshot above, Discountable has been re-titled as Dsctbl (so it will need less column
width on the Invoice), and Other 1 has been renamed Discnt$ because it will hold discount dol-
lar amounts.

Here's a partial view of the Invoice after customization, showing the added columns:

FormCalc SST Setup

1. Take a new snapshot of the Invoice. 

FormCalc SST will gather data about the Invoice form and build a new spreadsheet based on it,
in the Snapshot tab.

The snapshot taken in Part 1 cannot be reused, because the Invoice
form's layout has changed (columns were added).

2. Assign column types on the Column types row and column labels on the next row.

When you are done the two rows should look something like this:

3. Add the following formula in the Dscnt$ cell on the Formulas row.

=H20*J20

This formula multiplies the Dsctbl column (H) by the Amount column (J). Since Dsctbl will con-
tains a "1" for discountable items and nothing (equivalent to "0") for non-discountable Items, 
Dscnt$ will end up displaying amounts for only the discountable Items.

4. Enter the following formula in the Description column on the Item-triggered formulas 1 row:

="*** DISCOUNT of "&DOLLAR(SUM(I26:I28)*0.02,2)&" if paid by:
"&TEXTD(B6)&" ***"
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This formula does basically the same thing as the formula from Part 1 (see the formula break-
down in Part 1 for details). But this time it sums the Discnt$ column (I), so that the discount is
calculated only on the value of fertilizer Items in the Invoice, not on the Invoice total.

Here's a view of the snapshot with the formula in place:

Processing an Invoice

Here's the result of processing an Invoice in QuickBooks using this new FormCalc SST setup:

Do you see the problem?

The old customer message (from Part 1) wasn't fully erased before FormCalc SST wrote the new
one to the Invoice, with this being the result:

*** DISCOUNT of $108.29 if paid by:  
*** DISCOUNT of $91.50 if paid by: 4/2/2019 ***4/12/2019 ***
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This won't do! It's alerting us to the fact that if an Invoice gets processed a second time, the cus-
tomer message won't be displayed properly.

A simple fix

Formatting the Description column's results differently in FormCalc SST will fix the problem

1. Right-click on the Description column's cell on the Item-triggered formulas 1 row, and se-
lect the Format item from the pop-up menu. 

The Format data or results window will open.

2. In the right pane of the window, checkmark the Results replace Description option.
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This tells FormCalc SST to erase the contents of the Description column before writing results
there.

3. Click OK to close the window.

Processing an Invoice Again...Success!

And here's the result of processing the Invoice again. As you can see, the customer message
now correctly replaces the prior one.

Related topics:

Totaling or subtotaling a column
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Calculating rental days in a rental business (date
math)

This example demonstrates:

· How to calculate the number of days between two dates entered on an Invoice

· How to use IF() function logic to control where calculations are done (i.e., on which rows)

A Simple Date Math Example

For basic information on handling dates and times, see the topic Dates,
times, and date calculations.

Suppose an equipment rental business charges for equipment based on the number of days the
customer had it out on rental. They have customized the Invoice form in QuickBooks, adding
columns to hold the OUT date and IN date. Now they want FormCalc SST to calculate the number
of rental days based on dates entered in those two columns, with the calculated result placed in
the Quantity column.

To set up FormCalc SST for this, we would take a snapshot of the Invoice, indicate the column
types of columns in the Detail area, then enter a formula in the Quantity column like the following

=G18-G17

Here's a partial view of the Snapshot page in FormCalc SST, with the OUT Date and IN Date
columns formatted as dates and the Quantity column showing the formula.
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Here is another view. The Quantity column shows the formula's results, and below the formula
cell the Sample formulas and data rows show a range of sample results (based on the sample
data in those rows).

Switching to QuickBooks, then pressing the FormCalc SST hotkey (F11) twice to process the
form, gives this result:

Having verified that this FormCalc SST setup works as planned, we could use it on any Invoice
where the same kind of calculation is desired.

A real-world rental business may need more complex calculations than
shown here—like maybe calculating the number of days and half days an item
was out on rental. That is something FormCalc SST is fully capable of doing,
but it is beyond the scope of this simple example.

"Nothing" vs. a "Blank" Result

Suppose this same rental business also sells industrial cleaning supplies—mops, buckets, floor
buffer pads, cleaning solutions, etc. On invoice lines where cleaning supplies are entered, quantit-
ies need to be entered directly in the Quantity column, not calculated by FormCalc SST. In fact,
the FormCalc SST calculation described above would cause a problem on rows where cleaning
supplies are entered. Sincethose rows have no dates in the OUT Date and IN Date columns,
FormCalc SST would calculate a 0 (zero) result for them...overwriting the user-entered Quantity! 

Overcoming this problem is simple. FormCalc SST is designed so that it will not write a "nothing"
result to QuickBooks. So the formula needs to be enhanced a bit to use the IF() function in a way
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that says "If dates have been entered, calculate the Quantity, but if they are missing don't write
anything in the Quantity column." Here is a "new and improved" formula to be entered in the
Quantity column, in cell H18:

=IF(ISNUMBER(F18),G18-F18,"")

Breaking this formula down into its parts, it says that if cell F18 is a number, then calculate the
result as G18-F18, otherwise the result is "" (nothing).

There is a big difference between "nothing" and a blank space. The for-
mula described above specifies nothing as ""—two quotation marks with nothing
between them. Sometimes though, you may want a formula to write a "blank" or
"space" back to QuickBooks, which is not the same as nothing! In that case, you
would specify the result as " "—two quotation marks with a space between
them.

If we change the formula at cell H18, then use process an Invoice which contains both rental
items and cleaning supplies, FormCalc SST will calculate a quantity for just the rental item rows.
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Taxable & nontaxable items:  a mini-spreadsheet
example

This example demonstrates:

· Using FormCalc SST's "mini-spreadsheet" feature to do calculations which use data from
other rows of the form

· Using IF() function logic to determine calculation results based on contents of the Tax
column

· Entering data in header fields (fuel surcharge, freight charges) and using it in formulas

· Totaling a column on the form

· Protecting formulas from divide-by-zero errors

· How to set up trigger Items in the QuickBooks Item list

· Using trigger Items to control where calculations occur

This very complex example is based on a real-world problem FormCalc SST
was able to solve for one of our customers.

How to Use the Mini-Spreadsheet Feature for Multi-Row Calculations

Overview

Paul Hibbs is a partner in an industrial cleaning service specializing in cleaning machine tools and
parts, and paint and varnish removal. Paul's company often picks up parts at the customer's site,
cleans them at his facility, then delivers the cleaned tools or parts back to the customer. 

Business has been good, but the prospect of having to comply with new state sales tax rules is
taking some of the fun out of it! Customer invoices often have both taxable and non taxable items
on them—and QuickBooks handles the sales tax calculations on those without any problem. But
when parts are picked up and delivered freight charges and a fuel surcharge are usually involved.
And that's where the trouble begins.

As of January 1, 2014 Minnesota's sales tax regulations will require Paul to charge sales tax on
the freight charges and fuel surcharges in proportion to the dollar amount of taxable items on the
invoice. So if 62% of the rest of the invoice is taxable, then sales tax must be charged on 62% of
the freight charge and 62% of the fuel surcharge. (Do people in government ever fully comprehend
the burden laws and regulations can place on the everyday lives of the people they serve?)

Paul is looking for a solution which will calculate the sales-taxable portion of his invoices, including
the taxable part of freight and fuel surcharges, and that's something you can provide with
FormCalc SST. To set this up for Paul you will need to:

· Customize Paul's Invoice forms, adding two fields to the header area as places to enter
freight charge and fuel surcharge amounts, and adding two columns to the detail area which
FormCalc SST will use for separately tallying taxable and nontaxable amounts on the invoice.
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· Take a snapshot of the Invoice with FormCalc SST, and assign column types and column la-
bels.

· Add formulas to put taxable and nontaxable amounts in the appropriate (taxable or nontaxable)
column.

· Add Item-triggered formulas to total the taxable and nontaxable columns, and to calculate the
taxable and nontaxable portions of freight charges and of fuel surcharges.

QuickBooks Setup

Customizing the Invoice:  adding fields

If you need more detail on customizing Invoices, see the Customizing
QuickBooks forms (for FormCalc SST) topic.

1. Click on the command to customize the Invoice form's layout. 

The Additional Customization window will open.

Paul's staff needs header fields where freight charges and fuel surcharges can be entered.
QuickBooks doesn't provide any fields dedicated to those two jobs, but most other fields can be
used for such purposes. The main qualifications for fields you can use this way, is that (1) they
must not already be in use for other information Paul needs on Invoices, and (2) they must ac-
cept all kinds of data entries—which mostly means they cannot be date fields and cannot be
fields like the Terms or Rep fields, which only accept entries from their associated drop-down
lists. 

Paul is not using the S.O. No. and FOB fields on invoices, and they will work fine for holding
freight charges and fuel surcharges. All you need to do is add them to the Invoice and give them
more suitable titles.

2. On the Header tab of the Additional Customization window, checkmark boxes in the Screen

column for the S.O. No. and FOB fields and give them appropriate titles as shown in the

Title column in the screenshot below.
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Next you need to add two columns to the Invoice form's detail area, as places for FormCalc
SST to tally taxable and nontaxable amounts. Other 1 and Other 2 are spare fields you can
use for this purpose. They are not available on QuickBooks reports, but that's fine, because the
calculated results in them will never be needed on reports.

3. On the Columns tab of the Additional Customization window, checkmark boxes in the Screen

column for the Other 1 and Other 2 fields, and change their titles to Taxbl and

NonTaxbl, in the Title column.

You may also renumber the Order column to have these newly added columns appear where
you want them on the Invoice.
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Here's the Invoice after customization, showing the added header fields and added columns in
the detail area:

Adding some new Items

Using FormCalc SST's mini-spreadsheet feature requires using one or more QuickBooks Items
for triggering some Item-triggered calculations; that is, for indicating the rows on which calcula-
tions are to happen.

Existing Items can sometimes be used as trigger Items, but often some new ones must be ad-
ded. In this case, new Items are needed for taxable and nontaxable freight and fuel surcharges to
be calculated by FormCalc SST. They will be added near the bottom of Paul's invoices, arranged
something like this:
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Item order can be important, but row spacing never is! FormCalc SST ig-
nores blank rows. So the Items shown above could immediately follow each
other, or they could have one or two blank rows between them...it wouldn't
matter to FormCalc SST.

Here is the list of Items which need to be added:

Item
Type

Item
Name

Description Tax Code

Service FuelSurchT Fuel surcharge - Taxable Tax (taxable)

Service FuelSurchNT Fuel surcharge - Nontaxable Non (nontaxable)

Service FreightT Freight - Taxable Tax (taxable)

Service FreightNT Freight - Nontaxable Non (nontaxable)

Either Service or Non-inventory part Item types are usually best for creat-
ing trigger Items.

And here is a screenshot of the New Item window as one of these Items is being added:
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FormCalc SST Snapshot Setup

1. Select File > New from the main menu to start a new FormCalc SST file. 

(Optional. You may overwrite the existing file if you want.) 

2. Take a snapshot of the QuickBooks form.

FormCalc SST will gather data about the form and build a spreadsheet based on it.

3. Assign column types in the Detail area, to identify the spreadsheet's column types with their
corresponding QuickBooks columns. Enter column labels too, if you want, to have column
names which match those on the Invoice.

The column types and column labels rows should look something like the following when you
are done.

Also figure out which Header fields are the Fuel Surcharge and Freight fields, and label them.
That will make it easier to find them later, when building formulas which refer to them.

FormCalc SST: Add General Formulas

When FormCalc SST processes Invoices, the Formulas row's formulas will be applied to each
Item row on the Invoice (with the exception of Item-triggered formula rows, discussed farther be-
low). For this job you need to enter formulas which identify each row's amount as taxable or
nontaxable.
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1. Enter formulas for tallying taxable and nontaxable amounts, on the Formulas row. 

The Taxbl column's formula returns the Amount if the Tax column's contents begins with "T",
or a blank space if not:

=IF(LEFT(J21)="T",I21," ")

= Every formula begins with an equal sign (=).

IF(LEFT(J21)
="T"

If the first character of cell J21 (the Tax column) is "T", return the IF() func-
tion's first option; otherwise return the second.

I21 IF() function's first option:  return the amount from I21 (the Amount column).

" " IF() function's second option:  return a blank space.

 

The NonTaxbl column's formula returns a blank space if the Taxbl column contains a number;
otherwise it returns the Amount:

=IF(ISNUMBER(G21)," ",I21)

= Every formula begins with an equal sign (=).

IF(ISNUMBER(G21
)

If cell G21 contains a number, return the IF() function's first option; otherwise
return the second.

" " IF() function's first option:  return a blank space.

I21 IF() function's second option:  return the amount from I21 (the Amount
column).

"Playing" with the sample data

After you have entered these formulas FormCalc SST copies them to the sample data rows (im-
mediately below the Formulas row) to let you see how they work, using sample data which was
copied from the Invoice when the snapshot was taken. In this example the Amount column's val-
ues were all copied to the Taxbl column, as they should be—because all of the sample rows are
for taxable Items.
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The only problem is that this sample data doesn't test the formula in the NonTaxbl column. But
you you can edit the sample data to do that. Here's another screenshot, taken after making one of
the rows' Tax column entry from "Tax" to "Non". As you can see, the formula in the NonTaxbl
column seems to be working correctly too.

FormCalc SST: Add Item-Triggered Formulas

Now we can add the formulas which calculate the taxable and nontaxable portions of freight and of
fuel surcharges. The calculations will be triggered by the appearance of the Items added earlier—
which is why they are referred to as trigger Items.

Here are descriptions of the entries needed on four of the Item-triggered formulas rows.

Item-triggered formulas 1

1. In the Item column, enter "FuelSurchT"—the name of the taxable fuel surcharge Item. 

2. In the Taxbl column, enter a formula to total the Taxbl and NonTaxbl columns:
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=SUM(G27:G29)+SUM(H27:H29)

= Every formula begins with an equal sign (=).

SUM(G27:G29) Will sum the Taxbl column when an invoice is processed. (Referring the
range of sample data rows in a formula tells FormCalc SST to refer to the
entire column during form processing.)

+ Adds the two sums together.

SUM(H27:H29) Will sum the NonTaxbl column when an invoice is processed.

Remember, you can use "close enough" cell referencing. For instance,
you can enter the first SUM() above as SUM(G1:G1) and FormCalc SST will

correct it to refer to the range of sample data rows (which implies summing
the whole column, during form processing).

3. In the NonTaxbl column, enter a formula to calculate the taxable portion of the fuel sur-
charge:

=IF(H35<>0,B11*(SUM(G27:G29)/H35),0)

= Every formula begins with an equal sign (=).

IF(H35<>0 Using the IF() function this way protects against a divide-by-zero error, which
could occur in the unlikely even that cell H35 (the Taxbl + NonTaxbl total)
was zero.

B11 The total fuel surcharge amount entered in the form's Header.

*(SUM(G27:G29)/
H35)

Multiplies the total fuel surcharge amount by the invoice's taxable portion
(SUM(G27:G29)) of the invoice total (H35).

0) Returns 0 if H35 was zero (to prevent divide-by-zero errors).

Item-triggered formulas 2

This row's formula is the first one in this example to actually illustrate the
mini-spreadsheet idea, because it refers to an anchor row—which represents
a "prior row of data" during actual processing of an Invoice.

1. Show the anchor rows for Item-triggered formulas 2, using the Show/hide Anchor rows
button in the upper right corner of the main window. 
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Having the anchor rows visible will make formula entry easier to comprehend.

2. In the Item column, enter "FuelSurchNT"—the name of the nontaxable fuel surcharge Item.

3. In the Amount column, enter a formula to calculate the nontaxable portion of the fuel
surcharge:

=B11-I41

= Every formula begins with an equal sign (=).

B11 This references the fuel surcharge amount from the Invoice's header.

-I41 This refers to the prior row's Amount field, which calculated the amount of
taxable fuel surcharge, and subtracts  it  from the total fuel surcharge, leav-
ing the nontaxable amount as the result.

After entering the formula, the Amount cell should show the total fuel surcharge:

Why doesn't it just show the nontaxable portion? Because the anchor row the formula refers to
contains no data, which the formula interprets as a zero. To mimic what the formula will "see"
during actual form processing, you can enter some sample data in the anchor row cell the for-
mula refers to. In this example the taxable fuel surcharge amount calculated on the Item-
triggered formulas 1 row, has been entered in cell I41. Now the just-entered formula makes
sense, calculating the nontaxable amount as $21.64.
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You are free to enter data anywhere in anchor rows, as sample data for
your formulas to reference.

Item-triggered formulas 3

1. Show the anchor rows for Item-triggered formulas 3 and 4, as you did above. 

2. In the Item column, enter "FreightT"—the name of the taxable freight Item.

3. In the Taxbl column, enter a formula to total the Taxbl and NonTaxbl columns, the same
formula you entered on the Item-triggered formulas 2 row earler.

=SUM(G27:G29)+SUM(H27:H29)

Why use the same formula here as you did above? It makes the fuel surcharge and freight cal-
culations independent of each other. If Paul wants to charge for freight on an invoice without
adding a fuel surcharge, FormCalc SST will accommodate that.

4. In the NonTaxbl column, enter a formula to calculate the taxable portion of the freight:

=IF(H49<>0,B15*(SUM(G27:G29)/H49),0)

This is like the taxable fuel surcharge formula except that it refers to cell B15, the freight charge
field.

Item-triggered formulas 4

1. In the Item column, enter "FreightNT"—the name of the nontaxable freight Item. 

2. In the Amount column, enter a formula to calculate the nontaxable portion of the freight
charge:
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=B15-I55

This is like the nontaxable fuel surcharge formula except that it refers to cell B15, the freight
charge field. After entering this formula, its  cell shows the freight charge amount—$50.00 in
this example.

As happened for the nontaxable fuel surcharge calculation, this formula returns the entire freight
charge. The reason is that it is subtracting a blank cell (I55, which equates to zero) from the
freight charge (B15). To see whether the formula is calculating properly you only need to enter
sample data in the anchor row cell (I55), such as the taxable amount from the Item-triggered 3
row, $43.34:

The completed snapshot

Here's a view of the snapshot's Detail area tab with all formulas and item names in place.
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Processing an Invoice

On the first attempt at using this FormCalc SST setup to process an Invoice, QuickBooks
stopped the processing attempt with a pop-up message:
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The problem is that FormCalc SST is trying to write "63.4688757" in the Amount column (labeled
Net here), but QuickBooks won't accept more than two decimal places in that column.The solu-
tion is to change the format FormCalc SST uses for writing results to the Amount column.

Changing formats in the Amount column

1. In FormCalc SST, right click one of the Amount column formula cells, and select Format
from the pop-up menu. 

The Format data or results window will open.
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2. Select a two-digit number format, and be sure to turn off the Override spreadsheet

format option.

3. Click OK to close the window.

The cell's results should then be displayed with two-decimal places, like this.

4. Use the same steps to format each of the Amount column's formula cells.

When you are finished, they should look something like this (anchor rows have been hidden to
make the screenshot more compact):

"Why not format cells in the NonTaxbl column?" You can format them if
you want, but it isn't necessary, because:  (1) The NonTaxbl column is an



FormCalc SST for QuickBooks User's Guide108

Copyright © 1996-2013 Flagship Technologies, Inc. All rights reserved. (Rev. 11/15/2017)

Other column type. Unlike the Amount column, it will accept any number of
decimal places without complaint, and (2) Neither the Taxbl nor NonTaxbl
columns will appear on printed Invoices, so their appearance is of little im-
portance. If they were to be printed out for customers to see, then they cer-
tainly should be formatted!

Processing the Invoice Again...Success!

Here's the result of processing the Invoice again.

The taxable and nontaxable amounts are correctly calculated, based on the fuel surcharge
and freight amounts in the Invoice's header fields, and this FormCalc SST setup is ready to
use for processing Paul's invoices.
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Truck net weight and bushels of grain
calculations

This example demonstrates:

· Interdependent formulas; for example, column D depends on the result calculated in
column C, which depends on values from columns A and B. (Like any spreadsheet,
FormCalc SST handles formula dependencies automatically.)

· Using "dummy Items" for entering data on the invoice without recording income

· Calculating Item quantities from other data entered on the same row

· Protecting formulas from divide-by-zero errors

· Totaling a column

Calculate Net Weight and Bushels of Grain from Truck Loaded and
Empty Weights

Overview

Schaaf Farms and Trucking, LLC is a multi-generation family business producing feeder cattle
and grains—mostly corn, soybeans, and wheat—plus operating a trucking business. Over the
past few years they have edged into producing specialty grains:  organic soybeans and high-anti-
oxidant grain sorghum for the health food market.

Sales of the organic soybeans and grain sorghum are handled a lot differently than for generic,
commodity grains. These specialty grains are delivered on contract to two small, regional food
processing companies. Neither company's mill has a truck scale, so Schaaf's drivers have to
weigh loads at a nearby public scale, drive to the mill to dump their grain, then drive back to the
public scale to get a truck empty weight. Also, neither food company pays directly for the delivered
grain; rather, Schaaf Farms has to invoice them for it. Along with each invoice they include copies
of the scale tickets showing truck loaded and empty weights, plus calculations of the net weight
and number of bushels on each load and the per-bushel contract price.

Mary Schaaf does most of the operation's bookkeeping and follows these steps to do the (usually
weekly) invoicing:

1. As she gets time during the day she calculates a net weight for each unrecorded scale ticket,
using a calculator, and hand-writes the net weight on the ticket. 

2. When it's time to send an invoice she gathers the scale tickets for the week (typically for one to
three loads of grain) and uses a paper-tape adding machine to total the loads' net weights, then
divides by the number of pounds per bushel to calculate the total number of bushels delivered.

3. She verifies the paper tape's numbers against the net weights written on the tickets, then
staples the tape to copies of the scale tickets for sending along with the invoice.

4. She enters an invoice in QuickBooks for the total number of bushels at the contract price, and
prints it out.
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5. She mails the invoice to the food company along with the stapled-together scale tickets and
paper tape.

Someone told Mary she should be using an Excel spreadsheet for adding up the tickets and cal-
culating bushels. But she doesn't feel comfortable with Excel and knows it would require printing
out a separate, full-sized sheet of paper to send out with the invoices and scale tickets, so she
has continued using the paper-tape adding machine.

You tell her she could accomplish everything she does now by entering truck loaded and empty
weights directly into QuickBooks as she prepares each invoice and let FormCalc SST do all the
calculations. That would eliminate using the calculator and paper-tape adding machine and would
have the added benefit of documenting each truckload of grain (loaded, empty, and net weights) 
directly on the invoice, making that information available to anyone who reviews the invoice.

Mary gives you the go ahead to set this up for her.

QuickBooks Setup

Mary already has QuickBooks Items set up to record income from grain sales:

OrgSoybns
HASorghum

These will also work as trigger Items for FormCalc SST's calculation of total net weight and total
bushels. However, you need to set up a couple "dummy Items" (ones which don't record income)
to use on the invoice lines where truck weights are entered—one dummy Item for each grain.

Why two dummy Items? Because to calculate net bushels FormCalc SST will need the per-
bushel weight of the grain being sold. When one of these dummy items is selected on an invoice
you'd like that grain's per-bushel weight to appear on the same invoice line, to make it accessible
to FormCalc SST. The easy way to have that happen is to add a custom field to the Items list—
let's call it BuWt—then enter the appropriate per-bushel weight in that custom field for each
dummy Item. Of course, you will also need to customize the invoice template to include the cus-
tom field.

You will need several extra invoice columns for holding things like truck loaded and empty weights.
You can use the two spare columns Other 1 and Other 2 for this purpose, but they won't be
enough. To make another column available you will need to add yet another custom field, NetWt,
for the net weight calculated for each truckload.

For easy understanding this example uses the terms loaded weight, empty
weight, and net weight in place of the common commercial terms gross
weight, tare weight, and net weight, respectively.

1. Add the two dummy Items to the Items list. 
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2. Define custom fields in the Item list, named BuWt and NetWt:
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3. For each dummy Item, enter a per-bushel weight in the BuWt custom field. 

You don't need to enter anything in the NetWt field; it will be calculated by FormCalc SST.

4. Create a new Invoice template by copying the existing one and renaming it.

Mary will only be using the new invoice template for specialty grain invoices, so make a copy of
her existing invoice template, then customize the copy, leaving the original template available
for other invoicing.

5. Customize the new Invoice template to include the necessary columns.
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On the Columns tab:

· Checkmark the BuWt and NetWT custom fields—the ones added to the Item list earlier.

· Checkmark the Other 1 and Other 2 fields, renaming them LoadedWt and EmptyWt.

· Rename the Quantity field to Bushels. (This template will only be used for specialty grain
invoices, so that's OK.)

· Renumber the Order as desired, to arrange columns as you want them on the invoice
form.

6. Fill out the form as Mary normally would for one of the grains. 

Include at least three rows of sample truckload data for FormCalc SST to copy when taking a
snapshot of the form, and put the appropriate grain Item at the bottom:
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FormCalc SST Setup

1. Select File > New from the main menu to start a new FormCalc SST file. 

(Or, you may overwrite the existing file if you prefer.)

2. Take a snapshot of the QuickBooks form.

FormCalc SST will gather data about the form and build a spreadsheet based on it.

3. Assign column types on the Column types row, to identify the spreadsheet columns with their
corresponding QuickBooks columns.

The column types and column labels rows should look something like the following when you
are done, if you update the column labels to match the QuickBooks column names.

4. Format the NetWt cell to have no decimals, because truck weights are only recorded in
whole pounds.

Right-click on that cell (of the Formulas row), then select Format from the pop-up menu. The
Format data or results window will open, where you can select a format no decimal places as
shown here.
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5. Likewise, format the Bushels (Quantity) cell to also have two decimals:

6. Enter a formula to calculate the NetWt:

=G20-H20

which breaks down as:

= Every formula begins with an equal sign (=).

G20 The LoadedWt value.

-H20 Minus the EmptyWt value.

7. Enter a formula to calculate Bushels:

=IF(F20>0,I20/F20,0)

which breaks down as:

= Every formula begins with an equal sign (=).

IF(F20>0 This protects the formula against "divide by zero" errors. If the per-bushel
weight in F20 is greater than 0, the formula will use it to calculate bushels;
otherwise the formula will return 0 (see below).
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I20 The NetWt value.

/F20 Divided by the per-bushel weight value in BuWt.

,0) If F20 was 0 or negative, a zero result is returned.

Here's a view of the formulas:

...and the sample results they calculate:

8. Type "OrgSoybns" in the Item column on the Item-triggered formulas 1 row.

This makes OrgSoybns a trigger item for the formulas you will enter on this row.

9. Enter this formula In the NetWt column on the same row:

=SUM(I1:I1)

This is a shorthand way of saying "sum the entire column". As soon as you've entered it,
FormCalc SST converts the formula to:

=SUM(I26:I28)

which is the actual cell range that indicates to FormCalc SST to sum the entire column of net
weights.

10.Enter a similar formula in the Bushels column:

=SUM(J1:J1)
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Which FormCalc SST converts to:

=SUM(J26:J28)

After entering formulas the row may look something like this:

As you can see, the sample result shows bushels as 2498.3333. The cell needs to be format-
ted to show fewer decimal places.

11.Format the Bushels cell on the Item-triggered formulas 1 row, to have two decimals:

12.Enter similar formulas and formatting for the HASorghum Item, on the Item-triggered
formulas 2 row.

That way both trigger Items will be set up in FormCalc SST, so it will work with invoices in-
volving either OrgSoybns or HASorghum.

"But wait a minute! With the LoadSoy Item name on the Formulas row, won't
this setup only work for sales of soybeans?" No. Item names on the Formulas
row are always ignored for FormCalc SST calculations. The LoadSoy Item is
only there because it was part of the data FormCalc SST harvested when the
invoice snapshot was taken. The point to understand is that Item names
are only important on the Item-triggered formulas rows.
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13.Save the FormCalc SST file to prevent accidentally losing your changes.

Processing a QuickBooks Invoice

To verify that your FormCalc SST setup is working as desired, try processing the QuickBooks in-
voice you filled out earlier:

To invoke form processing from FormCalc SST

1. Press the Action button in FormCalc SST's main toolbar. 

The focus will switch to QuickBooks, and the Choose an action dialog will appear: 
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2. Click on the Process this QuickBooks form button to process the form. (See example res-
ults below.)

To invoke form processing from from QuickBooks

1. Press the FormCalc SST hotkey, which is F11 unless you have changed it in Preferences. 

The same Choose an action dialog as shown above will appear. 

2. Process the form by either pressing the hotkey a second time (quickest for most users), or

clicking on the Process the QuickBooks form button.

Results

The invoice should look something like the following after processing, with the weights and
bushels calculated as shown here.
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Adding line numbers to a packing slip (or
invoice)

This example demonstrates:

· How to auto-number the lines of a packing slip (or invoice, or sales receipt, or any other
QuickBooks form)

· How to use FormCalc SST's statistical function COUNTA

Adding Line Numbers to a Packing Slip (or Invoice)

Like many companies that ship out products, Deep Blue Pool Supply prepares and prints out
packing slips by applying a Packing Slip template to their QuickBooks invoices. Because the num-
ber of items being shipped can cause confusion as orders are filled, Deep Blue wants to add line
numbers to their packing slips. QuickBooks has no option for doing this, but it's simple to do with
FormCalc SST.  

QuickBooks Setup

Add a column to the Packing Slip (or Invoice) template, to hold the line numbers

1. Open the Invoice form. 

2. Apply the Packing Slip template you use, by selecting it in the invoice's Template field.

3. Click on Formatting > Customize Data Layout in the invoice form's menu/ribbon bar.

The Additional Customization window will open.
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4. Click on the Columns tab.

Now, you need an unused field you can add to the form to hold the line numbers. Other 1 and
Other 2 are spare fields available for any purpose, so use Other 1 if it is available.

If Other 1 and Other 2 are already in use, you can add a custom field to
the Items list to make an additional field available for adding to the packing
slip template when you customize it, as described below.

5. On the Other 1 line, checkmark the boxes in both the Screen and Print columns, change

the field's title to Line No., and enter 1 in the Order column to make Line No. the first field
on the form. (You don't have to make Line No. the first field, but that's where most people
prefer to see it.)

Also, be sure the Message field is selected on the Footer tab, even if

you don't need it. The Message field is required by FormCalc SST for navigat-
ing the invoice/packing slip form.
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6. Click OK to close the Additional Customization window.

Here's how the modified Packing Slip might look, with the added Line No. field:

For more customization details, see Customizing QuickBooks forms for
FormCalc SST.

FormCalc SST Setup

Take a snapshot of the Packing Slip form

FormCalc SST needs to take a snapshot of the Packing Slip (which is really an invoice with the
Packing Slip template applied).

1. Don't take a snapshot of a blank packing slip! Include at least three Item lines, as shown on
the form sample above. Also, enter "dummy" numbers in the Line No. column on all three lines
so that FormCalc SST won't think they are blank. 

2. In FormCalc SST, choose File > New from the main menu to begin a new file. 

This step assures you won't overwrite an existing FormCalc SST file. If you were taking a
second snapshot of a QuickBooks form—maybe because you had modified the form since the
prior snapshot—then you wouldn't need to start with a new file.

3. Click the Action button in the main toolbar.

The focus will switch to QuickBooks, and the Choose an action dialog will appear:
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4. Click on the New Snapshot button.

FormCalc SST will take a few seconds to gather information about the Packing Slip form, and
will then display a representation of the form on the Snapshot tab.

If you get a "No detail lines?" message while taking the snapshot, it is
because you failed to populate the Line No. column with a number on each
Item line. Do that, then take the snapshot again.

5. Indicate the column type of the Item column and the Line No. columns (at least).

You must always indicate which column is the Item column. Beyond that, you must also identify
the type for any column(s) which will have formulas in them, which in this case is just the Line
No. column. Identifying the types of other column is optional but very helpful. It helps you keep
track of "where you are" on the snapshot sheet, relative to the QuickBooks form's columns.

Here's a partial view of the snapshot with column types already selected for the Item column
and a few others, and the Line No. column's pop-up (right-click) menu displayed—Line No.'s
column type is about to be selected as Other.
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6. Enter a formula to generate the line numbers in the Line No. column.

Enter it this way:

=COUNTA(F1:F1)+1

This tells FormCalc SST that you want the formula to count all the non-blank cells in column F
(the Item column) and add 1 to that number each time the formula calculates. The  formula will
calculate on every line, it will number all lines which have an Item.

The reference to a cell range that involves just the first row of the worksheet (F1:F1) is a short-
hand way of telling FormCalc SST you want to include all rows of column F that are present at
the time the formula is calculated—i.e., when the QuickBooks form is being processed. Under-
stand that as soon as you've entered this formula FormCalc SST will convert it to a reference
to the sample rows area, which is the cell range FormCalc SST uses for keeping track of refer-
ences to "all rows" of any column. The adjusted formula will look like this:
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7. Click on the Save As button and supply a filename, to save the FormCalc SST file.

FormCalc SST files are identifiable by their .SSF filename extension.

All of the necessary setup is completed, and FormCalc SST is ready to use for adding line
numbers to QuickBooks Packing Slips.

Processing QuickBooks Packing Slips

To process a Packing Slip in QuickBooks:

1. In QuickBooks, open the Invoice for which you want to create a Packing Slip. 

2. Be sure your Packing Slip template is applied to the invoice. 

A FormCalc SST snapshot is specific to the template (field and column arrangement) that was
in use when the snapshot was taken. 

To use FormCalc SST with a different template you need to take a new snap-
shot, to update the FormCalc SST data file. To use FormCalc SST with sev-
eral different QuickBooks forms and/or templates, you may create a different
FormCalc SST data file for each.

3. Press the FormCalc SST hotkey, which is F11 unless you have changed it in Preferences.

The Choose an action dialog will appear:
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4. Process the form by either (1) pressing the hotkey a second time, or (2) clicking on the Pro-

cess this QuickBooks form button.

Here's a view of the form after FormCalc SST has added line numbers. 

Note that there's a blank line inserted between some of the Item lines in this example. That
was to demonstrate that this approach—the formula we used—only numbers lines that have
an Item name on them. As you can see, the blank line is not numbered (indicated by the red
arrow).
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"But I want every line numbered, including blank lines!"

If you'd prefer to have the blank lines numbered too, no problem. In fact there are a couple dif-
ferent ways to accomplish that.

One would be to just slightly change the formula from the example above. If you enter it this
way:

=COUNTA(D1:D1)+1

FormCalc SST will number every line.

If that approach doesn't make sense to you, here's an even simpler formula for the Line No.
column:

=D18+1

This formula simply adds 1 to the number from the row above it, thus numbering each line.
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More Things to Know
This section describes various FormCalc SST concepts.
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Form fields, columns, and column types
Here are some important concepts related to fields and columns on QuickBooks forms.

The terms field and column are basically interchangeable. Both refer to data entry
fields on a QuickBooks form, but column is only used when talking about columns in
the form's Detail area.

Which Fields and Columns are Accessible to FormCalc SST?

You might think that all fields on a QuickBooks form would be accessible, but that isn't so! Only
fields which are accessible according to the following rules can sources of data for FormCalc
SST formulas or destinations where it writes results.

· For Header and Footer fields:  if you can move into the field by pressing the Tab or Shift-Tab
keys, the field is accessible and can be used by FormCalc SST.

· For Detail area columns the rule is a bit different:  if you can move into the field by pressing the
Tab or Shift-Tab keys on a blank row of the form, then the column is accessible and can be
used by FormCalc SST.

Why must you be able to Tab into a column on a blank row of the form?
Because columns accessible on a blank row are accessible to all Item types,
not just a few.

This simple rule up many new FormCalc SST users! Understanding it will
make using FormCalc SST easier.

Most of the inaccessible fields are columns in the Detail area. Basically any column which has a
grayed background won't be accessible. Also, any column which is supported by some Item types
but not others won't be accessible. The following are examples:

Field Name Description

U/M Unit of Measure. This field is only supported for Inventory
Part Items, so it is not accessible to FormCalc SST.

MPN Manufacturer's Part Number. This field is available for
several Item types but not all, so it is not accessible to
FormCalc SST.

QuickBooks Column Types

After taking a snapshot of a QuickBooks form, one of the things you must do is assign column
types to columns in the Detail area—at least the Item column, plus any column(s) where you will
enter formulas. There are two reasons for this:

1. FormCalc SST must know the location of the Item column to navigate the form.

When the Item column contains no data for three successive rows, that tells FormCalc SST to
stop processing the Detail area of the form. 
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2. Some column types accept a limited range of data.

The Quantity and Rate (or Price) columns, for instance, accept only numbers and reject num-
bers with more than five decimal places. By indicating the column type of such columns you
give FormCalc SST the information it needs to help prevent errors by controlling the kind and
format of data sent to QuickBooks. ("Errors" in this case would be pop-up message windows in
QuickBooks which would cause form processing to stop.)

How to assign column types

There are two ways to assign a column's type:

A. Right-click the Column types row

· Right-click on the Column types row of the desired column, then select a column type from
the pop-up menu:

or... B. Use the Column type button in the Editing toolbar

1. Click on any cell in the desired column. 

2. Click the Column type button on the Editing toolbar:

3. A Column type dialog will open, where you can select a column type:
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Which column type should I assign?

In most cases the choice of column type will be obvious:   the Item column should be assigned
the Item column type; the Quantity column should be assigned the Quantity column type; and so
on.

But in a few cases you may not be sure which column type to use. Choosing between two of the
column types may sometimes seem unclear, so here is some guidance about using them:

Column Type Where to Use It

Custom Field Use this type for custom fields brought into the form from
the Item, Customer, Vendor, or Employee lists.

Other Other is for columns with an unknown type, such as the 

Other 1 and Other 2 columns which are selectable during
QuickBooks form customization.

Why don't I have to assign a type to Header and Footer fields?

Because FormCalc SST treats all Header and Footer fields the same—as the Custom Field type.

Why so many Header and Footer fields?

The first time or two that you take a snapshot of a QuickBooks form, you may notice that the
Header and Footer sections of the Snapshot page seem to have too many fields in them.

The reason is that some QuickBooks buttons and other form controls appear to FormCalc SST
as fields. Why is that? Because FormCalc SST follows the rules mentioned earlier in this section:
 anything which can be moved to using the Tab key is considered a field.
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If it seems there are too many fields in the Header section of the snapshot, you can verify them
this way:  click in to the very first field of the QuickBooks form, then observe where the caret
(cursor) stops each time you press the Tab key. You will find that each of these locations corres-
ponds to a row in the Header section of the snapshot.

To keep track of which of these locations corresponds to form fields you want FormCalc SST to
access, you can label the fields as described below.

Field Labels, Column Labels

When FormCalc SST takes a snapshot of a QuickBooks form, the form's field and column loca-
tions are copied to unlabeled cells in the Snapshot page. In other words, these cells contain no in-
formation which can tell you the name of the corresponding QuickBooks form field or column.

FormCalc SST does not label snapshot fields and columns automatically, be-
cause it cannot obtain that information from QuickBooks.

The form data copied into each cell gives a clue about its corresponding field; but still, having no
label on each field makes formula entry more difficult/confusing than it should be.

The purpose of Field labels columns and the Column labels row is to give you a place to label the
fields and columns of the snapshot. Using them is completely optional, but it can be a big help in
"keeping your bearings" within the snapshot page, so that the formulas you enter will refer to the
desired fields and columns.

Choosing a Column type automatically enters a suggested label for the
column; however, you may change the label to anything you want.
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Formulas and cell references
FormCalc SST formulas are similar to those in other spreadsheet programs.

Formula Requirements

The main requirement, is that all formulas begin with an equal sign ('='):

=SUM(E19,B7:B9)

=34.5*H14

=TODAY()

Beyond this requirement of course, the formula must also be "legal"—it must be constructed
properly and cannot reference out-of-bounds cells or cell ranges, etc.

In the Snapshot sheet, cells containing valid formulas are highlighted with a
yellow background, and those which have errors are highlighted with a red
background.

Where You May Enter Formulas

This screenshot below shows the areas where you may enter formulas in FormCalc SST.
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Most of your formulas will be entered in either these two areas:

· Formulas row:  formulas entered here will be applied to every row of data on your QuickBooks
form except rows processed by Item-triggered formulas.

· Item-triggered formulas rows:  formulas entered on these rows get applied only to Quick-
Books form rows which have a matching Item name. (This lets you control where special calcu-
lations like totals or subtotals get done, by your placement of certain Item names on the form.)

References to Other Cells and Cell Ranges

Cell references in formulas

To refer to another cell in a formula, enter the cell's coordinates. For instance, the following for-
mula multiplies 34.5 times the value in cell H14.

=34.5*H14

To refer to a range of cells, specify the coordinates of the upper left and lower right cells of the
range, separated  by a colon (':'). This formula sums the range of cells consisting of B7, B8, and
B9:
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=SUM(B7:B9)

As you may have guessed from the "upper left and lower right" phrase
in the above paragraph, a cell range may refer to a block of cells which spans
more than one row and/or column.

Cell referencing limitations

To prevent errors, FormCalc SST only allows formulas to refer to specific cell ranges on the
Snapshot page. Each formula is checked as you enter it, and if the formula refers to an out-of-
bounds cell one of two things will happen:

1. The formula will be highlighted in the error color (red background), or 

2. A message will be displayed telling you FormCalc SST has adjusted (corrected) the for-
mula's cell references.

Allowed cell references:

Header formu-
las

Can refer to other Header cells, to Footer cells, and to the entire
range of Formulas (Detail) cells but not to individual Formulas
cells.

Formulas row
formulas
(in the Detail
area)

Can refer to Header cells, Footer cells, other cells on the Formu-
las row, and to the entire range of Formulas (Detail) cells.

Item-triggered
formulas
(in the Detail
area)

Can refer to Header cells, Footer cells, other cells on the same
Item-triggered formula row (i.e., not on other Item-triggered
rows), cells on the Item-triggered row's anchor rows, and to the
entire range of Formulas (Detail) cells. (Item-triggered rows have
several anchor rows, to support the mini-spreadsheet feature.)

Footer formu-
las

Can refer to other Footer cells, to Header cells, and to the entire
range of Formulas (Detail) cells but not to individual Formulas
cells.
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References to Footer fields can be legal (allowed) without being practical.

Most formulas which refer to either the Header or Footer areas will refer to Header
fields and not to Footer fields. Why?

1. Custom fields from the Customer and Vendor lists can only appear in the
form's Header. So formulas which access this sort of custom field data must
refer to cells in the Header section. 

2. In most Footer fields, data entry must be done by selecting an option from a
drop-down list. Until FormCalc SST can work with drop-down lists, it won't be
able to work with those fields—even though they appear in the Footer section of
the Snapshot page.
 
Often, the only Footer field FormCalc SST may be able to work with is the
Memo field, if it is present.

Referring to "a whole column"—the entire range of Formulas (Detail) cells
...or "Close Enough" cell references

A frequent need in FormCalc SST formulas is to refer to an entire column of data in the Detail
area of a QuickBooks form—to total the column, get an average or count of items in it, or to do
other calculations based on the whole column. But since the entire possible range of Detail cells
is not present in a snapshot, how do you tell FormCalc SST that is what you want? 

The solution is simple:  have your formula refer to a cell range which includes the first and last row
in the sample rows part of the Detail area. (Sample rows are the ones with tan backgrounds, im-
mediately below the Formulas row.) For example, suppose you are creating a formula on the
Item-triggered formulas 1 row, and you want it to total the Quantity column, which happens to be
column H of the form snapshot. You would enter the formula something like this:

=SUM(H24:H26)

As the red box indicates in the screenshot below, this formula refers to a cell range which in-
cludes the first and last sample row in column H:

During form processing, FormCalc SST will convert this sample rows reference into a reference
to the form's entire column of Quantity data.
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Actually, there's an even easier way. Instead of the formula shown above, you could enter any of
the following combinations (and many others):

=SUM(H1:H1)

=SUM(H5:H9)

=SUM(H3:H12)

In other words, just have your formula refer to the desired column (H in this case) and any range
of rows above the Detail area of the snapshot. FormCalc SST will immediately and automatically
convert what you enter to a reference to the appropriate range of sample rows. So the result of
any of the three entries above will be:

=SUM(H24:H26)

Entering "whole column" cell ranges in the form "=SUM(H1:H1)" is easi-
est. That way, you don't have to be concerned with knowing the exact be-

ginning/ending coordinates of the sample rows area. 
 

Understanding how references to a "whole Detail column" really work.

As mentioned, FormCalc SST changes these references at runtime (when pro-
cessing a QuickBooks form) to refer to the actual set of Detail rows present at the
time, but there is one more important point to understand:

· The formula references are changed to refer to all Detail rows up to and includ-
ing the prior row. In other words, "all Detail rows" does not include the Quick-
Books form row which is currently being processed.
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Anchor rows for your formulas
Anchor rows allow your FormCalc SST formulas to refer to QuickBooks form data which won't actually
be available until a form is being processed. In other words, they serve as "place holders" for Quick-
Books data which will be available "later", when FormCalc SST is processing the form.

Where are They?

On the Snapshot page, every Detail area row which allows formula entry has at least one anchor
row immediately above it. The Formulas and Sample formulas and data rows each have one an-
chor row:

Item-triggered formula rows each have five anchor rows, which allows them to support the mini-
spreadsheet feature. This screenshot shows the anchor rows for the Item-triggered formulas 2
row:

But I don't see them on my Snapshot page...where are they?

You won't need anchor rows all of the time—and some people may never use them—so they are
hidden by default. You can show or hide them by using the [ A ] button menu in the upper right
corner of the main window:
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How Do I Use Anchor Rows?

A common use for anchor rows is in formulas which compute a running total or other calculation
involving data from the "prior" row on the form. 

Here's an example. The following formula, entered on the Formulas row, refers to the anchor row
in a way which will compute a running total in the Quantity column.

For details, see the Running total calculation topic in How-To Examples.

Another, more advanced, use of anchor rows is in building formulas which may refer to sev-
eral prior rows of data. See the the mini-spreadsheet topic for a discussion of that technique.

Can I enter formulas or sample data in anchor rows?

You may enter sample data on them, but not formulas. 

Entering example data on anchor rows is a way to create a "mock environment" for testing your
formulas. This is especially helpful when several anchor rows are available, as for Item-triggered
formula rows. 
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The following example from the mini-spreadsheet topic shows how data entered on anchor rows
lets you see immediate results for formulas entered on the Item-triggered row. Without this ex-
ample data (444.00 and 10.00) the first real test of those formulas would come when a Quick-
Books form was actually processed.

You can change data on anchor rows as often as you like, to see how
your formulas work with different data.
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Item-triggered formulas
This topic provides details related to Item-triggered formulas.

FAQ (Frequently Asked Questions)

"Where are Item-triggered formula rows located?"

You will find them toward the bottom of the Detail section on the Snapshot page. Prior to version 3
FormCalc SST supported five Item-triggered formulas; beginning with version 3 it now supports
ten.

"Why are they called 'Item-triggered' formulas?"

Because they are formulas which FormCalc SST only applies when it encounters a specific Item
name on a QuickBooks form. That is, the Item name "triggers" the formulas.

QuickBooks Items used with Item-triggered formulas are sometimes referred
to simply as trigger Items.

"What are Item-triggered formulas used for?"

Their most common use is for totaling and subtotaling columns on QuickBooks forms, but they
are also used for doing calculations across several rows of a QuickBooks form—referred to as
the mini-spreadsheet feature.

"What Item types should I use with them?"

See the subtopic below, Tips for Items (for Item-triggered Formulas).

"How should I enter Item names for Item-triggered formulas?"

You can enter Item names in FormCalc SST so that they will match Item names in QuickBooks,
in one of two ways:

v Exact match. This happens when an Item name you have entered in FormCalc SST exactly

matches an Item name in QuickBooks—except that capitalization is ignored:  ItemName,
itemname, and ITeMNAMe would all be matches for a QuickBooks Item named ItemName.

v Wildcard match. This happens if you have used wildcard characters in an Item name in
FormCalc SST and a QuickBooks Item name is encountered which matches the wildcard
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name. FormCalc SST supports * and ? as wildcard characters:  * matches any number of
characters in an Item name, and ? matches any single character. Examples:

Local Tax* would match these QuickBooks Item names:

Local Tax - Jacksonville
Local Tax - Key West
Local Tax - Orlando

Local Tax - Jack* would match these QuickBooks Item names:

Local Tax - Jacksonville
Local Tax - Jacksonville Beach

But not:

Local Tax - Key West
Local Tax - Orlando

Local Tax 3?? would match all of these QuickBooks Item names:

Local Tax 301
Local Tax 348

But not:

Local Tax 214
Local Tax 179

"Why does FormCalc SST have more than one Item-triggered formula row?"

This allows you to set up several different sets of formulas, each triggered by the appearance of a
different Item name on a QuickBooks form. For instance, you might have set of formulas for sub-
totaling a column, and another set for providing a grand total or for totaling other data.

"Can the same trigger Item appear more than once on a form?"

Yes. That's how subtotaling is usually done:  you insert the Item name on each QuickBooks form
row where you want a subtotal calculated. Each time FormCalc SST encounters the Item name, it
then provide a subtotal for all rows since the most recent prior occurrence of the Item name.

Tips for Trigger Items
(Items Used with Item-triggered Formulas)

· FormCalc SST can work with any QuickBooks Item name, but single-level Item names like
"MyItem" are generally easier to work with than multi-level Item names like "MyItem:MySubItem",
because less typing is required.

· It's best to set up a few QuickBooks Items specifically for working with FormCalc SST's Item-
triggered formulas. This lets you give them descriptive Item names like "Subtotal", "Total", or
"Labor Hours Subtotal". It also prevents conflicts with other Item uses such as inventory man-
agement or for recording sales.
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· We recommend these item types for use with Item-triggered formulas:

Service
Non-inventory Part
Other Charge

Most other item types should be avoided as FormCalc SST trigger
Items, because using those other types for triggering calculations may inad-
vertently affect inventories or account balances in ways you did not intend.

· Avoid the following Item types as FormCalc SST trigger Items:

Subtotal
Group
Discount
Payment
Sales Tax Item
Sales Tax Group

Why? bbecause (1) they block FormCalc SST's access to some QuickBooks form columns,
and (2) FormCalc SST may even malfunction if you use them!

· There two possible accounting objectives for FormCalc SST trigger Items:  either (1) you do
want them to post income/expense when used on a form, or (2) you do not want them to post
income/expense when used.

When you do want the Item to post income/expense...

These will usually be Items which already exist in your QuickBooks Items list—Items you are
already using. For example, maybe you have a Freight  Charges Item and you want FormCalc
SST to calculate the freight amount on invoice lines where this Item name appears. In such situ-
ations you simply use the existing Item name (Freight Charges) as a FormCalc SST trigger
Item—you do not need to set up a separate Item for that purpose.

When you do not want the Item to post income/expense...

When an Item is being used only to trigger a FormCalc SST calculation, you need to guard
against using the Item in a way that accidentally posts income or expense.

The only way to accidentally post income or expense by using an Item with
FormCalc SST, is if a FormCalc SST formula writes its results into the Rate
or Amount columns of your QuickBooks form.

The Item types recommended as FormCalc SST trigger Items (Service, Non-inventory Part,
and Other Charge) require you to specify a posting account when you set up the Item, so one
way to avoid accidentally posting income or expense with these Item types is by making them
post to an equity-type account which you've created specifically for this purpose. You might cre-
ate an equity-type account named something like "FormCalc SST Item Postings" (to remind you
of its purpose), and use it as the posting account for any FormCalc SST trigger Items you set
up.

The benefit of using a separate equity account like this, is that it makes finding errors easier.
How? The account should never have a balance unless an amount has been posted to it. So if
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you look at the Chart of Accounts list or print a balance sheet and notice a balance for the
"FormCalc SST Item Postings" account, you will immediately know that you need to investigate
to find out why some transaction are posting to that account.
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Re-using formulas from the prior Snapshot

Where are My Old Formulas?

When you take a new snapshot of a QuickBooks form, it will overwrite any formulas you may have
entered on the Snapshot tab of  the current FormCalc SST file. 

If you've spent much time entering formulas, having them overwritten this way can be disappoint-
ing...until you learn that FormCalc SST makes a copy of them each time you take a new snap-
shot. Where is this copy of your formulas? On the OLD Snapshot tab.

To retrieve and reuse your old formulas, click on the OLD Snapshot tab. There you will find a copy
of the text and formulas which were on the Snapshot tab immediately before taking the current
snapshot. You can Copy (to the Windows clipboard) individual cells' formulas here, then go to the
Snapshot tab and Paste them into the desired locations.

Notes:

· Copy and Paste formula cells individually rather than as groups of cells. FormCalc SST's
formula checking logic may raise errors when a group of formulas is Pasted in.

· If you needed to take the new snapshot because of rearrangement of your QuickBooks form, 
many of the formulas you Copy and Paste into the Snapshot sheet may have to be adjusted
(edited) after Pasting them in.
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Mini-spreadsheet basics
The mini-spreadsheet feature lets you do calculations access to multiple rows and columns of data on
your QuickBooks forms.t

The Mini-Spreadsheet Idea

Mini-spreadsheets are just an extension of the anchor rows concept. They provide a way for for-
mulas to refer to "prior" rows on the QuickBooks form:

· The Formulas row has a single anchor row above it, giving its formulas access to the immedi-
ately-prior row of data on a QuickBooks form.

· Item-triggered formula rows each have five anchor rows above them, giving them access to the
five prior rows of data. (Blank rows are ignored and are not included in the count of data rows.)

Here is a screenshot of an Item-triggered formulas row on a Snapshot page, with its anchor rows
section expanded. The red arrows indicate the vertical range of the Item-triggered formulas 2
row and its five anchor rows. 

See the anchor rows topic for details about showing/hiding anchor rows.

Think of this block of cells as representing up to six rows in the Detail section of a QuickBooks
form. Formulas on the Item-triggered formulas 2 row can refer to any of its anchor row cells,
and when a QuickBooks form is processed those formulas will actually refer to data fields of the
five rows of QuickBooks data above the row where the trigger Item appears.

A Quick Mini-Spreadsheet Example

Here is an example to help you understand the relationship between anchor rows and QuickBooks
form rows.

This screenshot shows a QuickBooks Invoice with several rows of data. The last row holds a trig-
ger Item for an Item-triggered formula, indicated by a red arrow.
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Below is a screenshot of an Item-triggered formulas row in FormCalc SST with two simple formu-
las, both of which refer to anchor row cells. 

The formulas aren't intended to solve a real-world problem, they
just demonstrate how mini-spreadsheets work.

Things to note:

· The formula in the Other column multiplies a value from the third-prior anchor row by
1.77:
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=F40*1.77

· The formula in the Quantity column divides the result of the first formula by an amount
from the 1st-prior anchor row (the fifth anchor row from the top).

=F43/G42

· Sample data has been entered in anchor row cells targeted by the formulas, to allow
seeing formula results immediately.

You may enter sample data anywhere in anchor rows, and change or
delete it whenever you wish.

· The trigger Item name shown on the QuickBooks form, ATriggerItem, has been entered

on the Item-triggered formulas 2 row.

Here's another screenshot of the same area, with calculated results showing in the formula cells.

When we process the QuickBooks Invoice shown earlier, this is the result:
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Points to note about mini-spreadsheets:

1. Mini-spreadsheet formulas refer to QuickBooks form rows relative to the row where the trigger
item is encountered on the form. 

2. FormCalc SST ignores blank lines between data rows on your forms. Said differently,
FormCalc SST operates as if QuickBooks forms have no blank lines at all.

This can lead to some confusion until you get used to it. Like FormCalc SST, you must remem-
ber to ignore blank lines as you build mini-spreadsheet formulas!

See also

A mini-spreadsheet example
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Dates, times, and date calculations
If you have limited spreadsheet experience, the following introduction to how spreadsheets store dates
and times will help you quickly become comfortable with handling date and time information in
FormCalc SST, allowing you to do date and time calculations and much more.

How Spreadsheets Store Dates and Times

Spreadsheets—and many other computer programs—internally represent date and time informa-
tion as a single number. The following number represents 7:50 am. on November 15, 2013:

41593.327

The whole-number part (41593) represents the date, November 15, 2013, and the fractional part
(.327) represents the time, 7:50 am. 

This is sometimes called the "1900 date system" because the whole
number part represents the number of days elapsed since January 1, 1900.

Probably the two most important things to know about dates and/or times stored this way are:

1. Because dates and times are stored as numbers, date and time math is easy. 

If today is represented by 41593 and yesterday is represented by 41592, it's easy to see how
you can calculate the number of days between two dates (41593 - 41592 = 1 day). Calculating
the number of hours, minutes, and seconds between two times is just as easy.

2. You can format date/time numbers in many different ways.

Here are differently-formatted representations of 41593.327:

11/15/2013 Date only

11/15/2013 7:50:52 AM Mixed date and time

7:50 AM Time only

15.November.13 ...and many other ways

Changing the format of a date/time number does not change the number,
only the way it is displayed.

See also:

A simple date math example
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Formatting data and calculated results
Like most spreadsheets, FormCalc SST gives you options for formatting calculated results (for writing
back to QuickBooks), and also for formatting data cells—cells which don't contain formulas but to
which your formulas may refer.

Why Format Cells?

Formula Cells

The results calculated by formulas get written to your QuickBooks form. So, formatting formula
cells not only makes calculated results more readable in FormCalc SST but also determines how
those results will appear in QuickBooks.

Data cells

Data cells are those which don't contain formulas but to which formulas may refer. For instance, if
a formula on the Formulas row refers to a cell in the Header section for a number it uses, you may
consider that Header cell a data cell. The formula might also refer to some other cell on the For-
mulas row, or to a cell on its anchors row. Both could be considered data cells.

Formatting data cells is always optional. The main reason to do so is to make the sample data
they contain (if any) more readable. 

For example, spreadsheet cells represent date and time data internally as a decimal number such
as 41596.775—something most of us would not recognize easily as a date or time. But a Date or
Time format can be applied to 41596.775 so that it is displayed as 18 November 2013 or as
6:35pm. (The date and time are both encoded in the number 41596.775.)

You use the Format data or results dialog (described next) to format both data cells and formula
cells.

Formatting a Cell

To format a cell, use the Format data or results dialog:

1. Click on the cell you want to format. 

FormCalc SST's main focus is on formatting formula cells. So if you click
on an anchor row or other nearby cell, the formula cell may be the one which
actually gets formatted.

2. Either click on the Format button in the editing toolbar, or right-click the cell and select
Format from the pop-up menu, as shown below.



More Things to Know 153

Copyright © 1996-2013 Flagship Technologies, Inc. All rights reserved. (Rev. 11/15/2017)

The Format data or results dialog will open (shown farther below)

3. Select the formatting options you want.

4. Click OK to close the dialog.

The Format data or results Dialog

The column type of the current Snapshot column determines which
formats are available. If a format isn't available in this dialog and you think
it should be, check to see it the correct column type has been assigned.
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Spreadsheet format

This section in the left pane of the dialog, is where you choose a format type and a format to
apply to the cell you are formatting.

QuickBooks output

This section in the right pane of the dialog, gives you additional control over how the cell's cal-
culated results will be sent to QuickBooks.

Numbers

The spreadsheet formatting options available for numbers (in the left pane) are a bit limited.
Many of them support no more than two decimal places, while some QuickBooks fields allow
up to five decimal places (Quantity and Rate columns) or more. The Numbers section lets
you override a spreadsheet cell's format when sending its calculated result to QuickBooks,
giving you more control over decimal places and whether commas are used.

Though omitted from the screenshot above, newer editions of FormCalc SST support yet an-
other kind of override:  sending results to QuickBooks as mixed fractions. For instance, if a
result is calculated in FormCalc SST as 1.75, selecting this override sends the result to
QuickBooks as 1-3/4. Negative numbers are sent surrounded by parentheses:  -2.5 would be
displayed as (2-1/2).

Description column output

This section only appears when you are formatting the Description column.

As you probably know, when you select an Item on a QuickBooks form the Description
column is automatically filled with the Item's description. You may or may not want to over-
write the Item description with results sent from FormCalc SST. This section gives you op-
tions for whether or not to overwrite the description, whether results appear on a separate line
from it, and how many spaces to indent the results.

"Help bubbles"

Help bubbles provide detailed information about the various formatting options.. Hovering the
mouse cursor over a help bubble displays a pop-up window with information about the adja-
cent option.
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QuickBooks Sales Orders and Purchase Orders
QuickBooks' Sales Order and Purchase Order forms work a bit different from other forms. To prevent
confusion when working with them in FormCalc SST you need to understand those differences.

Working with Sales Order (SO) and Purchase Order (PO) Forms

Unique Columns in SOs and POs

QuickBooks may automatically add some of the following columns toward the right side of a SO
or PO form:

Clsd  (Closed)

Rcv'd (Received)

Bkordered (Backordered)

Invoiced

These columns may not necessarily appear when you first enter lines on a new PO or SO. Often
they will be added later if/when you edit the form. The Backordered column may not appear until
you receive Items against a PO, for instance.

QuickBooks displays the Rcv'd, Invoiced, and Backordered columns with a gray background, in-
dicating they are not directly accessible to you. However, the Clsd column is not grayed by Quick-
Books, so it is accessible to you but works differently from other columns. FormCalc SST cannot
read from or write to the Clsd column. That's something you probably wouldn't want FormCalc
SST to do anyway, but you need to understand that trying to write to it will likely cause QuickBooks
to display an error message.

Another column to know about...

Man. Part Num (Manufacturer's Part Number)

The Man. Part Num column, if you include it in your PO form's template, is most peculiar of all.
QuickBooks sometimes makes it inaccessible. FormCalc SST was not designed to handle this
situation; however, working around the problem is easy, as described below.

In some cases FormCalc SST can detect that a QuickBooks form's column
such as Clsd is inaccessible to it. When that happens, FormCalc SST displays
**No Access** in that column of the Snapshot worksheet.

Rules for using FormCalc SST with SO and PO Forms

1. Don't try to read from or write to the Clsd column with FormCalc SST. It will fail. 

2. In PO forms, always set up the form template so that the Man. Part Num column comes after
(to the right of) any columns referenced by your FormCalc SST layout. Otherwise, FormCalc
SST likely will not be able to process the form.
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Running multiple instances of FormCalc SST

Some FormCalc SST users need to be able to do calculations on two or more different Quick-
Books forms, such as Invoices and Sales Receipts, at any time—because they may enter sales
on either form at any time.

This was a problem in older FormCalc SST versions because they only allowed running a single
instance of the program at a time. If you had a data file (*.SSF) loaded for doing calculations on an
Invoice, for instance, then wanted to apply calculations to a Sales Receipt, you first had to go to
FormCalc SST and manually load a different data file—one set up for working with Sales Re-
ceipts.

This is no longer a problem however, beginning with FormCalc SST version 3. Now you can run
multiple instances of the FormCalc SST program, and each instance (each running copy of the
program) can have a different data file loaded, with a different hotkey assigned to it. So if you want
to be able to quickly apply calculations to Invoices and also to Sales Receipts, you can start two
copies of FormCalc SST and load a different data file into each one. (The number of FormCalc
SST instances you can run at one time is essentially unlimited.)

The most important consideration for running multiple FormCalc SST instances, is to assign a dif-
ferent hotkey to the data file (*.SSF) you load in each one. To assign a different hotkey to a data
file:
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1. Open the desired data file (*.SSF) in FormCalc SST (File > Open). 

2. Set the hotkey in the Preferences dialog (Edit > Preferences).

3. Save the data file (File > Save) to preserve your hotkey setting for that file.

What happens if you load two data files which both use the same
hotkey? When you load the second file, FormCalc SST will display a message
saying it could not register the file's hotkey. The solution is to set a different
hotkey for the file, then close it and reopen it.
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Using the Scratchpad

The Scratchpad is an area on the Snapshot tab, to the right of the columns which represent native
columns of the QuickBooks form. It consists of ten blank columns colored with a light yellow back-
ground. In the Scratchpad, you can enter formulas which refer to the native QuickBooks columns.
Also, formulas entered in the native columns can refer to cells in the Scratchpad. 

In the example above, a formula entered on the Formulas row of the Scratchpad, =F18*G18, will
calculate an extended weight for each line of an invoice, by multiplying the Unit Weight by the
Quantity on each line. Presumably, a trigger Item named ShipWt will be selected somewhere to-
ward the bottom of the invoice, and it will total the Extd Wt. column of the Scratchpad, to provide a
total shipping weight for the entire invoice.

The Scratchpad lets you do things like create subtotals and totals of the QuickBooks form's
columns, or do other intermediate calculations, without adding additional custom columns to the
QuickBooks form (Invoice, Sales Receipt, etc.). This provides several benefits:

1. Using the Scratchpad sometimes frees up custom fields for other uses in QuickBooks.
This can be especially important if you need a large number of custom fields (columns) for
data but the number of custom fields available in your QuickBooks edition (such as Quick-
Books Pro) is limited. 

2. Sometimes, you may be able to add new calculations for a QuickBooks form without taking
a new snapshot of the form. If you can add the new calculation in a Scratchpad column in-
stead of modifying the form's layout, taking a new Snapshot won't be necessary.

3. The Scratchpad lets you do some kinds of calculations more simply than if all formulas had
to be entered in (match up with) native QuickBooks columns. For instance, in some situations
the Scratchpad lets you avoid using long formulas containing IF() statements.

4. Using the Scratchpad often makes FormCalc SST run faster! How? If you can remove cus-
tom columns from the Items area of a QuickBooks form (because they are no longer needed
for use by FormCalc SST), the form will have fewer columns for to travel over as it gathers
data and processes calculations. Fewer columns to travel over means quicker operation!
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Spreadsheet Reference
This section is a reference to the operators and functions available for building formulas in FormCalc
SST's.



FormCalc SST for QuickBooks User's Guide160

Copyright © 1996-2013 Flagship Technologies, Inc. All rights reserved. (Rev. 11/15/2017)

Arithmetic & logical operators
FormCalc SST's spreadsheet has the following built-in operators.

Arithmetic Operators

Arithmetic operators let you perform basic arithmetic operations.

Symbol Operand Type Example Explanation

+ Two arguments =B1+5 Adds the first argument’s value to the value
of the second argument.

- Two arguments =A5-B1 Subtracts the second argument’s value from
the value of the first one.

* Two arguments =A2*A3 Multiplies the first argument’s value by the
value of the second argument.

/ Two arguments =A15/7.33 Divides the first argument’s value by the
value of the second argument.

^ Two arguments =B1^A2 Raises the first argument’s value to the
power determined by the second argument’s
value.

Logical Operators

Logical operators perform comparisons and return a logical value (TRUE or FALSE) as a result.

Symbol Operand Type Example Explanation

= Two arguments
of logical types

=A1=A2 Equality.  Returns TRUE if the first argument
is equal to the second one.  Otherwise, re-
turns FALSE.

<> Two arguments
of logical types

=A1<>B2 Inequality or "not equal".  Returns TRUE if
values within the list are not equal.  Other-
wise, returns FALSE.

< Two arguments
of logical types

=A2<B4 Less than.  Returns TRUE if the first argu-
ment is less than the second one.  Otherwise,
returns FALSE.

> Two arguments
of logical types

=A12>100 Greater than.  Returns TRUE if the first ar-
gument is greater than the second one. 
Otherwise, returns FALSE.

<= Two arguments
of logical types

=A2<=C4 Less than or equal to.  Returns TRUE if the
first argument is less than or equal to the
second one.  Otherwise, returns FALSE.

>= Two arguments
of logical types

=A2>=2.45 Greater than or equal to.  Returns TRUE if
the first argument is greater than or equal to
the second one.  Otherwise, returns FALSE.
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Function reference
FormCalc SST's spreadsheet has the following built-in functions.

Arithmetic Functions

A set of mathematic and trigonometric functions.

In this table a double value means a number which may consist of a whole number
part and a fractional part, in contrast to an integer value, which consists only of a
whole number.

Symbol Operand Type Example Explanation

ABS One argument of
double type

=ABS(B6) Returns the absolute value.

ACOS One argument of
double type

=ACOS(B16) Returns the arccosine.

ACOSH One argument of
double type

=ACOSH(A1) Returns the inverse hyperbolic cosine.

ASIN One argument of
double type

=ASIN(B7) Returns the arcsine.

ASINH One argument of
double type

=ASINH(B5) Returns the inverse hyperbolic sine of
the argument.

ATAN One argument of
double type

=ATAN(C5) Returns the arctangent.

ATAN2 One argument of
double type

=ATAN2(C3) Returns the arctangent using x- and
y- coordinates.

ATANH One argument of
double type

=ATANH(D4) Returns the inverse hyperbolic tan-
gent.

CEILING Two arguments
of double type

=CEILING(A6,1) Rounds the first argument up to the
nearest multiple based on the signific-
ance specified by the second argu-
ment.

COS One argument of
double type

=COS(A5) Returns the cosine. 

COSH One argument of
double type

=COSH(D4) Returns the hyperbolic cosine.

COUNTIF Two arguments:
 a range of cells
and a condition
of type string

=COUNTIF(B3:B7,">2") Counts the number of nonblank cells
within a range which meet a given
condition.

DEGREES One argument of
double type that

=DEGREES(PI()/2) Converts radians to degrees.
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Symbol Operand Type Example Explanation

specifies an
angle in radians

EVEN One argument of
double type

=EVEN(-1.59) Rounds the argument up to the
nearest even integer.

EXP One argument of
double type

=EXP(C1) Returns the exponent value of the ar-
gument.

FACT One nonnegative
argument

=FACT(5) Returns the factorial of the argument.

FLOOR Two arguments
of double type

=FLOOR(-2.5,-2) Rounds the first argument down, to-
wards zero, to the nearest multiple of
the significance specified by the
second argument.

INT One argument of
double type

=INT(E4) Rounds the argument down to the
nearest integer.

LN One argument of
double type

=LN(C1) Returns the natural logarithm.

LOG Two arguments:
the number and
the base

=LOG(100,10) Returns the logarithm of a number to
the specified base.

LOG10 One argument of
double type

=LOG10(1000) Returns the base-10 logarithm of the
argument.

MOD Two arguments:
a number and di-
visor

=MOD(4,3) Returns the remainder after the num-
ber is divided by the divisor.

ODD One argument of
double type

=ODD(3.5) Rounds the argument up to the
nearest odd integer.

PI No arguments
required

=PI() Returns the value of Pi.

POWER Two arguments
of double type:
the number and
the power

=POWER(A1,4) Raises the number to the base.

RADIANS One argument of
type double
which specifies
angle in degrees

=RADIANS(180) Converts degrees to radians.

RAND No arguments
required

=RAND() Returns a random number between 0
and 1.

ROUND Two arguments:
the number of
double type and
the number of
digits

=ROUND(20.57,1) Rounds the first argument to the spe-
cified number of digits.



Spreadsheet Reference 163

Copyright © 1996-2013 Flagship Technologies, Inc. All rights reserved. (Rev. 11/15/2017)

Symbol Operand Type Example Explanation

ROUNDDOWN Two arguments
of double type

=ROUNDDOWN(2.75,0) Rounds the argument toward zero. 
The first argument specifies a number
to round up.  The second argument
defines the number of digits to which
you want to round the first argument.

ROUNDUP Two arguments
of double type

=ROUNDUP(-3.42,1) Rounds the argument toward infinity.
 The first argument specifies a num-
ber to round up.  The second argu-
ment defines the number of digits to
which you want to round the first ar-
gument.

SIGN One argument of
double type

=SIGN(A2) Returns the sign.

SIN One argument of
double type

=SIN(A1) Returns the sine.

SINH One argument of
double type

=SINH(1) Returns the hyperbolic sine.

SQRT One argument of
double type

=SQRT(B5) Returns the square root.

SUM A list of argu-
ments

=SUM(A1:C12)
=SUM(A1, 3.14, 1.57)

Sums all the values in the list.

SUMSQ A list of argu-
ments

=SUMSQ(B1:D1)
=SUMSQ(1,2,3,4)

Sums the square of values in the list.

TAN One argument of
double type

=TAN(C3) Returns the tangent.

TANH One argument of
double type

=TANH(0) Returns the hyperbolic tangent.

TRUNC One argument of
double type

=TRUNC(PI()) Returns the integer part. (Compare
this with the INT function, which re-
turns a double.)

Statistical Functions

Basic statistical functions.

Symbol Operand Type Example Explanation

AVERAGE A list of argu-
ments

=AVERAGE(A1:A5)
=AVERAGE(10.3,9.1)

Calculates the average value of val-
ues within the list.

AVERAGEA A list of argu-
ments

=AVERAGEA(A1:A5) Calculates the average value of the
non-empty cells refer-
enced.AVERAGEA(range) equals
SUM(range)/COUNTA(range).
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Symbol Operand Type Example Explanation

COUNT A list of argu-
ments

=COUNT(A1:A4)
=COUNT(1,5,8)

Returns the count of the number of
cells in a given range.

COUNTA A list of argu-
ments

=COUNTA(A1:A4) Counts the number of non-empty
cells in a given range.

COUNTBLANK A list of argu-
ments

=COUNTBLANK(A1:E1) Counts the number of empty cells.

MAX A list of argu-
ments

=MAX(A1:D1)
=MAX(A1,100,C2)

Returns the largest argument value.

MIN A list of argu-
ments

=MIN(A1:D1)
=MIN(0, C2)

Returns the smallest argument value.

SUM A list of argu-
ments

=SUM(A1:C12)
=SUM(A1,3.14,1.57)

Sums values within the list.

SUMSQ A list of argu-
ments

=SUMSQ(B1:D1)
=SUMSQ(1,2,3,4)

Sums squares of values within the
list.

Logical Functions

Logical functions take logical values as arguments and return a logical value as a result.

Symbol Operand Type Example Explanation

AND A list of logical argu-
ments

=AND(1<B4,B4<100) Logical AND operation.
 
Returns TRUE if all values within the
list are TRUE; returns FALSE if one or
more values within the list evaluates
to FALSE.

FALSE No arguments re-
quired

=FALSE() Returns the logical value FALSE.

IF Three arguments:
the logical expres-
sion, the value to re-
turn if the expression
succeeds, the value
to return the expres-
sion fails

=IF(A10<=100,
"Within budget", "Over
budget")

Returns the second argument if the
logical expression evaluates to TRUE
and the third argument otherwise.

NOT One argument of lo-
gical type

=NOT(1>D4) Logical NOT operation.

Reverses the value of its argument.

OR A list of logical argu-
ments

=OR(A1>=10, A1<=–
10)

Logical OR operation.Returns TRUE if
any argument is TRUE; returns FALSE
if all values within the list evaluate to
FALSE.
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Symbol Operand Type Example Explanation

TRUE No arguments re-
quired

=TRUE() Returns the logical value TRUE.

Date and Time Functions

Symbol Operand Type Example Explanation

DATE Three operands
defining the
year, month and
day

=DATE(1900,1,1) Calculates the serial number that rep-
resents a specified date.

DAY One argument
defining the
serial number of
the desired date

=DAY(TODAY()) Returns the day portion of a given
date.

HOUR One argument
defining the
serial number of
the desired
date/time value

=HOUR(NOW()) Returns the hour portion of a given
date/time value.

MONTH One argument
defining the
serial number of
the required date

=MONTH(TODAY()) Returns the month portion of a given
date.

MINUTE One argument
defining the
serial number of
the desired
date/time value

=MINUTE(NOW()) Returns the minutes portion of a
given date/time value.

NOW No arguments
required

=NOW() Returns the current time in general
format. You can apply other format-
ting to display the result as a date, a
time, or a mixed date/time.

SECOND One argument
defining the
serial number of
the desired
date/time value

=SECOND(NOW()) Returns the seconds portion of a
given date/time value.

TIME Three arguments
defining hour,
minute and
second parts of
a time value

=TIME(16,48,10) Returns a decimal value for the spe-
cified time.

TODAY No arguments
required

=TODAY() Returns the serial number of the cur-
rent date.
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Symbol Operand Type Example Explanation

WEEKDAY Two arguments:
the serial number
of the required
date, weekday
base

=WEEKDAY(TODAY())

=WEEKDAY(DATE(2002,
12, 1),1)
...returns 1(Sunday)

Returns the day of the week corres-
ponding to the specified date.

The weekday base identifies the
first day of the week and determines
the return value type: 

1 or omitted: the first day of the
week is Sunday. (The function re-
turns 1 for Sunday, 2 for Monday,
etc.)

2: the first day of the week is
Monday. (The function returns 1 for
Monday, 2 for Tuesday, etc.)

3: the first day of the week is Tues-
day. (The function returns 0 for
Monday, 1 for Tuesday, etc.)

YEAR One argument
defining the
serial number of
the required date

=YEAR(TODAY()) Returns the year portion of a given
date.

Data Management Functions

Special FormCalc SST functions for extracting and storing data.

Symbol Operand Type Example Explanation

GET1
GET2
GET3
GET4
GET5
GET6
GET7
GET8
GET9

No arguments
required

=GET1()
=GET3()

The GET functions return the number
stored in the memory location corres-
ponding to the numeral at the end of
the word GET. Numbers are stored in
those locations by a STOR function.
For example, if a cell has the formula
=STOR7(44.785), then another cell
with the formula =GET7() would re-
turn the result 44.785 in the second
cell.

The memory locations referenced by
STOR and GET functions are global
across all macros, which means data
can be stored in them (STOR) by one
macro and accessed (GET) by other
macros.
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Symbol Operand Type Example Explanation

There are several important limita-
tions for using these functions:  for
details, see Using STOR and GET
functions.

GETVAL Two arguments
of type string

=GETVAL(D5,"Wt")
=GETVAL(D5,"Cases")

Extracts the data value named by the
second argument, from the text string
defined by the first argument. Data
values in the text string must be
stored in a specific format. See the 
GETVAL function reference topic for
examples and data storage rules.

STOR1
STOR2
STOR3
STOR4
STOR5
STOR6
STOR7
STOR8
STOR9

=STOR1()
=STOR3()

The STOR functions store a number in
the memory location corresponding to
the numeral at the end of the word
STOR. Numbers stored in those loca-
tions can be retrieved by a GET func-
tion. For example, if a cell has the
formula =STOR7(44.785), then an-
other cell with the formula =GET7()
would return the result 44.785 in the
second cell.

The memory locations referenced by
STOR and GET functions are global
across all macros, which means data
can be stored in them (STOR) by one
macro and accessed (GET) by other
macros.

There are several important limita-
tions for using these functions:  for
details, see Using STOR and GET
functions.

Text Functions

Symbol Operand Type Example Explanation

& (ampersand) Two arguments of
type string

="Yellow "&"river Concatenates specified strings.

CONCATENATE A list of strings =CONCATENATE("John
"," Doe")

Joins several text strings in one
text string. (An alternative to
"&".)

DOLLAR Two arguments de-
fining the value and
the number of digits
to the right of the

=DOLLAR(957.344,2) Converts the number to text us-
ing currency format
$#,##0.00_);($#,##0.00), with
the decimals rounded to the
specified number of places.
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Symbol Operand Type Example Explanation

decimal point in the
output string

FIXED The first argument
of type double is
required. The
second argument of
type integer is op-
tional (the default
value is 2). The
third argument of
type Boolean is op-
tional.

=FIXED(1234.567,1) Rounds the first argument to
the number of decimals determ-
ined by the second argument
and returns it as a string.

The third argument (which must
be TRUE or FALSE) specifies
whether to omit commas in the
output string. 

LEFT The first argument
of type string is re-
quired. The second
argument of type
integer is optional.

=LEFT(A1)

=LEFT(A1, 3)

Returns the first character or
characters in a text string.

The second argument defines
the number of characters to ex-
tract. The default value is 1.

LEN One argument of
type string.

=LEN("ABC") Returns the length of the string
argument.

LOWER One argument of
type string.

=LOWER(A1) Converts a string to lowercase.

MID The first argument
is of type string,
the second and the
third arguments are
of type integer.

=MID("ABC",3,1) Returns the substring of a given
text string. The position of the
substring is defined by the
second argument. The third ar-
gument specifies the number of
characters to extract.

RIGHT The first argument
of type string is re-
quired. The second
argument of type
integer is optional.

=RIGHT(B2,3) Returns the last character or
characters in a text string.

The second argument defines
the number of characters to ex-
tract. The default value is 1.

TEXTD The first argument
of type double is
required. The
second argument of
type string is op-
tional.

=TEXTD(A1)
=TEXTD(NOW())

=TEXTD(A1,
"mm/dd/yyyy")

Returns a text string for the
date defined by the date/time
value in first argument, format-
ted according to the current
short date format. (Time is not
included.)
 
When two arguments are sup-
plied, the date/time value
defined by the first argument is
formatted according to the
format defined by the second
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Symbol Operand Type Example Explanation

argument. (See the TEXTD
formatting characters.)

TRIM One argument of
type string.

=TRIM("   Some text 
 ")

Removes all spaces from text
except for single spaces
between words.

UPPER One argument of
type string.

=UPPER(A1&A2) Converts a text string to upper-
case.

IS Functions

These functions test the type of a value and return a Boolean result.

Symbol Operand Type Example Explanation

ISBLANK A value of any type =ISBLANK(A1) Returns TRUE if cell is empty.

ISERR A value of any type =ISERR(H1) Returns TRUE if the cell contains
any error value except #N/A.

ISERROR A value of any type =ISERROR(A7) Returns TRUE if the cell contains
any error value (#N/A, #VALUE!,
#REF!, #DIV/0!, #NUM!, #NAME?,
or #NULL!).

ISLOGICAL A value of any type =ISLOGICAL(C3) Returns TRUE if the specified value
refers to a logical value.

ISNA A value of any type =ISNA(E5) Returns TRUE if the cell contains
#N/A (value not available) error
value.

ISNONTEXT A value of any type =ISNONTEXT(D4) Returns TRUE if the cell does not
contain text.
(Returns TRUE for blank cells,
also.)

ISNUMBER A value of any type =ISNUMBER(A2) Returns TRUE if the cell contains a
number.

ISTEXT A value of any type =ISTEXT(D1) Returns TRUE if the specified cell
contains text.
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GETVAL function reference
The GETVAL function allows formulas to extract data values from text strings—a handy feature for
storing data in programs with no spare numeric or text storage locations. An example will best ex-
plain how it works:

Example:  Suppose a Description column (field) in your accounting program contains the follow-
ing text:

SillySpray child's lawn sprinkler [Wt=3.8;Cs=12]

The square brackets surround the text area from which GETVAL can extract data. Here, Wt identi-
fies the per-unit weight of a SillySpray sprinkler (3.8 pounds), and Cs is the number of sprinklers
per case (12).

If the above Description field text corresponds to cell D7 in FormCalc SST, this formula would ex-
tract the per-unit weight and the number of sprinklers per case, and multiply them to calculate the
weight per case:

=GETVAL(D7,"Wt")*GETVAL(D7,"Cs")

What if the goal was to calculate a shipping weight for each line of an invoice? If cell D9 corres-
ponds to a quantity of items, and D7 holds the same Description text described above, this for-
mula would multiply the weight per item by the quantity of items ordered, thus calculating the ship-
ping weight on that line of the invoice:

=GETVAL(D7,"Wt")*D9

You may store and retrieve numbers, or text, or both using this
technique.

GETVAL Data Storage Rules

For GETVAL to extract data from a text string, the data must be stored according to the following
rules.
 

[ ] The data block must begin and end with square brackets.

name=value Each data item within the block must consist of a data name and a data
value, separated by an equal sign. Data names are not case sensitive. so
these data names are all equivalent:  

Wt,  wT,  wt,  WT

; (semicolon) If the data block contains more than one data item they must be separated
by a semicolon character.

spaces Extra spaces are between data items and delimiters are ignored. Text data
items are not required to have surrounding quotation marks except when
they contain spaces which you want to preserve.

block location FormCalc SST searches for the data block from the right-hand end of the
source text string. So square brackets  may appear elsewhere in the
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source text so long as they are to the left of the data block.
 

Examples:

[Name=John] ...no quotation marks needed

[Name="John Doe"] ...quotation marks required, because of space

[Wt=44;Len=55.75] ...typical

[  Wt=44;  Len=55.75  ] ...extra spaces will be ignored

[Wt=34.  7] ...error! (space within a data value)
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Using STOR and GET functions
The STOR functions let you store numbers in nine memory locations numbered 1..9. For in-
stance, the formula =STOR4(F5) would store the value from cell F5 in memory location 4. The 
GET functions retrieve the numbers stored in those in nine memory locations. For instance, the
formula =GET4() would return the value stored in memory location 4.

These functions greatly enhance the flexibility and usefulness of FormCalc SST macros, but to
use them properly you must be mindful of their limitations.

Why Use STOR and GET?

· Using STOR and GET in formulas can sometimes be an easier way to reference data in your
formulas, compared to storing the data in a Scratchpad column.

· Using STOR and GET is currently the only way to pass data between macros.

For instance, suppose you have one macro with the formula =STOR4(F5), to store the value
from cell F5 in memory location 4, and you have a second macro with the formula =GET4( ) in it
somewhere. If you run the first macro, then run the second macro, the second macro will return
the memory location 4 value stored by the first macro.

If you have computer programming experience you may recognize that
FormCalc SST's STOR and GET memory locations are global, meaning they are
accessible to all macros.

Considerations for Using STOR and GET

The main thing you must be mindful of when using STOR and GET functions, is assuring that a
formula containing a STOR gets called before any formula which contains a corresponding GET.

This is not a problem when the STOR and GET are in two different macros:  you just need to run
the macro containing the STOR first, before the one containing the GET.

Where it can be a problem is when STOR and GET are used in the same macro. The most com-
mon problem with using STOR and GET functions in the same macro worksheet is failing to in-
sure that the formula containing the STOR is called before any formulas containing a correspond-
ing GET for the same memory location.

Contrast this with what you know about spreadsheet formulas. When a
spreadsheet formula references other cells in a worksheet and those cells
also contain formulas, there is an internal mechanism which insures that
those other cells are recalculated before their formula results are used in the
first formula.
 
With FormCalc SST's memory locations no such mechanism is available for de-
termining how formulas containing GETs are dependent on formulas containing
STORs.

How can you insure that formulas are called in the right order? The proper approach will depend
on the calculation situation you face:
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§ If the GET is used on the Formulas row of the worksheet (i.e., the GET is applied to every row of
the target form, such as an invoice), then you might make sure that an IItem-triggered formula
containing the STOR gets called on the first row of the invoice—before other rows where the
GET might be called. This is a technique used in accessing header fields in QuickBooks Online
or QuickBooks desktop editions, for instance.

§ If the GET is used on a Item-triggered formula row, then you need to assure that either a Formu-
las row formula or another text-triggered formula containing the corresponding STOR gets
called before the formula containing the GET. 

 For instance, suppose you have a text-triggered formula row which calculates a gratuity on the
last line of invoices for your catering business. If a formula on that row contains a GET to re-
trieve the invoice subtotal on which the gratuity is calculated, then you just need to be sure that
the text-triggered row which subtotaled the invoice and STORed that amount appears above the
gratuity row on the invoice.
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TEXTD format characters

TEXTD Format Characters

The TEXTD function gives you flexible options for formatting date/time values, using combinations
of formatting specifiers from the table below.

Examples:

TEXTD(NOW(),"mm/dd/yyyy" 11/23/2013

TEXTD(NOW(),"mm/dd/yy hh:nn am/pm" 11/23/13 10:45 am

Terms like "short date format" and "long time format" in the explanations below refer to
the Windows Regional settings for date and time formats, which you may change in
the Windows Control Panel.

Format
Specifier

Explanation

c Displays the date formatted using the current short date format, followed by the
time formatted using the current long time format. No time is displayed if the frac-
tional part of the date/time value is zero.

d Displays the day as a number without a leading zero (1-31).

dd Displays the day as a number with a leading zero (01-31).

ddd Displays the day as an abbreviation (Sun-Sat) using the current short day names.

dddd Displays the day as a full name (Sunday-Saturday) using the current long day
names.

ddddd Displays the date using the current short date format.

dddddd Displays the date using the current long date format.

m Displays the month as a number without a leading zero (1-12). However, if the m
specifier immediately follows an h or hh specifier, the minute rather than the month
is displayed.

mm Displays the month as a number with a leading zero (01-12). However, if the mm
specifier immediately follows an h or hh specifier, the minute rather than the month
is displayed.

mmm Displays the month as an abbreviation (Jan-Dec) using the current short month
names.

mmmm Displays the month as a full name (January-December) using the current long month
names.

yy Displays the year as a two-digit number (00-99).

yyyy Displays the year as a four-digit number (0000-9999).
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Format
Specifier

Explanation

h Displays the hour without a leading zero (0-23).

hh Displays the hour with a leading zero (00-23).

n Displays the minute without a leading zero (0-59).

nn Displays the minute with a leading zero (00-59).

s Displays the second without a leading zero (0-59).

ss Displays the second with a leading zero (00-59).

z Displays the millisecond without a leading zero (0-999).

zzz Displays the millisecond with leading zeros (000-999).

t Displays the time using the current short time format.

tt Displays the time using the current long time format.

am/pm Uses the 12-hour clock for the preceding h or hh specifier, and displays 'am' for any
hour before noon, and 'pm' for any hour after noon. The am/pm specifier can use
lower, upper, or mixed case, and the result is displayed accordingly.

a/p Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' for any
hour before noon, and 'p' for any hour after noon. The a/p specifier can use lower,
upper, or mixed case, and the result is displayed accordingly.

ampm Uses the 12-hour clock for the preceding h or hh specifier, and displays the current
TimeAMString value for any hour before noon, and the current TimePMString value
for any hour after noon.

/ Displays the date separator character indicated by your Windows Regional settings.

: Displays the time separator character indicated by your Windows Regional settings.

'some
text'

Characters enclosed in single quotes can appear in the format string and are dis-
played as-is. They do not affect formatting.
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Other Reference Topics
This section is a collection of miscellaneous reference topics.
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The Preferences dialog
Like QuickBooks, FormCalc SST has a Preferences dialog where you can change most program set-
tings.

Preference Dialog

· To open the Preferences dialog, select Edit > Preferences from the main menu. 

Categories and category pages

Select a category and category page to work with, from the category list in the left pane.

Collapse/expand category button

Clicking this button in a category's heading lets you collapse or expand the category's list of
pages.

"Help bubbles"

Help bubbles provide detailed information about each Preference settings. Hovering the
mouse cursor over a help bubble displays a pop-up window with information about the adja-
cent setting.
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FormCalc SST files and file management
Here are details about working with FormCalc SST data files.

Password Protecting FormCalc SST Files

FormCalc SST gives you a way to protect data files from unauthorized changes with a simple
password-protect-on-save option.

How to password protect a file

1. When saving a file for the first time (i.e., when using File > Save As), FormCalc SST will ask
if you want to password protect the file. 

If FormCalc SST fails to ask, it's likely that you have turned off the mes-
sage. To re-enable it open the Preferences dialog, find the page with a Re-en-
able all "Don't show again" messages button, and click it.

2. Click on the Yes button if you want to password protect the file.

The Create File Password dialog will open.

3. Enter the password you want to use.

4. Click OK to close the dialog.

A file save dialog will open.

5. In the file save dialog, choose a location (folder) and name for the file.

6. Click Save to save the file and close the dialog.
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File passwords FAQ

When will FormCalc SST ask for the password?

Because this is a password-protect-on-save system, FormCalc SST will only ask for the pass-
word when you save the file. This protects it from unauthorized changes but not from unauthor-
ized access and use.

Also, once you have supplied the file's password, FormCalc SST won't ask you for it again during
the current session. In other words, you will be able to save the file repeatedly without having to
supply the password each time. For added security then, when you are done editing and saving a
file, be sure to close and reopen the file (or exit and restart FormCalc SST). This will reset the
file's password entry for the session, so that anyone wanting to save the file again will have to
supply the password.

Who can access the file or use it in FormCalc SST?

Anyone with sufficient Windows login permissions to access the folder where the file is located
can use the file in FormCalc SST, copy it to other locations, etc.) The file's password does not
limit access; it only prevents unauthorized users from making changes to the file.

Having a password does not protect a file from being deleted! To pre-
vent unauthorized users from deleting files, either make the files read-only, or
limit users to read-only access to the folder where the files reside.

What if I forget the password?

No problem! Just open the file in FormCalc SST and use File > Save As to save it under a different
name—and optionally, password protect this new copy of the file.

.SSF versus .SST Files

Early versions of FormCalc SST used the .SST extension for data file names; for example, 
mydatafile.sst. The current version uses .SSF instead; for example, mydatafile.ssf.

Why the change? Some FormCalc SST users were sharing common data files by putting them in
a DropBox folder (  www.dropbox.com). For most file types this would have caused no problem
whatsoever. But the .SST extension is also used for Microsoft Serialized Certificate Store files,
and placing one of FormCalc SST's .SST files in a DropBox folder caused Windows to try to auto-
matically access it as a Serialized Certificate Store file, resulting in an error message. Due to the
popularity of DropBox, we switched to using a different filename extension to avoid problems for
FormCalc SST users.

Must my files have the .SSF extension?

No. Though .SSF is now the recommended filename extension, FormCalc SST will still load .SST
files. 

http://www.dropbox.com
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However, if you have files with the .SST extension and want to use them with DropBox or a similar
file synchronization service, you may need to load them into FormCalc SST and choose File >

SaveAs to save them with the .SSF extension.

Or you can simply rename the files manually (changing the extension to .SSF) in Windows Ex-
plorer or another file manager. This is permissible because .SSF and .SST files are identical in-
ternally.

File Management FAQ

(FAQ = Frequently Asked Questions.)

How are FormCalc SST files identified?

FormCalc SST files all have the filename extension .SSF (.SST in prior versions).

Are .SSF files compatible with Microsoft Excel?

Yes and no:

· You may be able to load an .SSF file into Microsoft Excel, depending on which functions are
present in the file used. (Not all FormCalc SST spreadsheet functions are compatible with Ex-
cel.)

· You cannot load files saved from Microsoft Excel into FormCalc SST, even if they have the .SSF
filename extension.

Where are .SSF files stored?

By default, FormCalc SST stores files in a folder location like the following (varies slightly depend-
ing on the version of Microsoft Windows you use):

C:\Users\Public\Documents\FormCalcSST

However, you may store the files in any location you prefer.

Can I access .SSF files across a network?

Yes. Unlike the old version of FormCalc (FormCalc SST's predecessor), FormCalc SST can work
with files stored anywhere on a network. This, along with password protection, lets you store .SSF
files in a central location for access by all FormCalc SST users, with little risk of users making file
changes which might negatively affect other users.

Backup your .SSF files often! Passwords and read-only access are no pro-
tection against losing files due to a hard drive crash, fire, or flood.

Can two or more users share .SSF files by putting them in a DropBox folder?

Yes. This is how some users share .SSF files without being on the same local area network.
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Special keys and shortcuts

Using the FormCalc SST Hotkey (Invoking FormCalc SST)

Most of the time you will invoke FormCalc SST directly from QuickBooks while working in the form
you want to process, by pressing the FormCalc SST hotkey (which by default is the F11 key, un-
less you change it in Preferences) . There are two ways to use the hotkey to process the form:

1. Keyboard and Mouse

Press the FormCalc SST hotkey once to display the Choose an action menu, then click the Pro-
cess this QuickBooks form button.

2. Keyboard Only

Press the FormCalc SST hotkey once to display the Choose an action menu, then press it again
to process the form.

This method is usually faster, because it only requires two presses of the same key.
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Keystrokes

F1 Opens the FormCalc SST Help system.

F2 Opens the editor for the current spreadsheet cell.

F11 (when pressed in QuickBooks) Invokes FormCalc SST.
(F11 is the default FormCalc SST hotkey but may be changed in Preferences.)

Ctrl-x
Ctrl-c
Ctrl-v

Respectively, these invoke the Cut, Copy, or Paste commands, to copy data
to/from the Windows clipboard.

Ctrl-z Undo the most recent spreadsheet operation.

Shift-Ctrl-z Redo the most recent Undo operation.

Other Shortcuts

Double-click (on a spreadsheet cell) Opens the editor for the current spreadsheet cell.

Right-click (on a spreadsheet cell) Displays a pop-up menu for the cell, if any is available.
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Troubleshooting

Troubleshooting

Pressing the hotkey (F11) in QuickBooks does nothing.

Try the following:

1. Shut down FormCalc SST, then right-click the icon you use for starting it and choose the Run

as administrator option. 

2. If the first step doesn't work, restart Windows, then try the Run as administrator option again.

When I try to process calculations on my QuickBooks form the cursor seems to jump
around from field to field forever, without getting any calculations done. Eventually I have
to abort the FormCalc SST's calculations by clicking on a different window.

Here are possible causes:

A. The snapshot no longer matches the form's field layout, as when you have added or re-
moved fields on the form. The solution is to take a new snapshot. 

B. The form does not have a Customer Message or Vendor Message field in the footer.
This field is absolutely required by FormCalc SST for navigating the form.

I am getting a "...could not locate QuickBooks window..." message, and FormCalc SST
can neither take a snapshot nor process my QuickBooks form.

1. In QuickBooks, be sure the desired form is "focused". For instance, if you want to work with an
invoice click in a field of the Invoice form before invoking FormCalc SST. 

2. If step 1 doesn't help, try the Run as administrator steps described above in the Pressing the
hotkey (F11) in QuickBooks does nothing topic.

FormCalc SST seems slow when processing a form. Can it work faster?

This can happen if you the Keystroke delay set too high in Preferences.
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Experiment with smaller Keystroke delay values this way:  try decreasing the number by 5 or 10
units. If FormCalc SST seems to work properly at that Keystroke delay setting, decrease by an-
other 5 or 10 units and try again. Keep decreasing and/or increasing the Keystroke delay setting
until you find the smallest value which still allows FormCalc SST to work reliably, then increase it
by 5 units for safety. A typical Keystroke delay setting is 20.

Help! FormCalc SST is sending keystrokes to QuickBooks and I don't know how to make it
stop!

If there's ever a problem while FormCalc SST is processing a QuickBooks form, just click on an-
other non-QuickBooks window or on the Windows taskbar. (You'll have to click on the Windows
taskbar if QuickBooks is maximized so that no other windows are visible.)

To fix problems created by keystrokes sent to the wrong part of a QuickBooks form you can use
the QuickBooks revert command (Edit > Revert), if it is supported by your version of QuickBooks.

Note:  Edit > Revert returns the form to the state in which you last saved it. If

you have edited the form but not yet saved your changes, Edit > Revert will

simply delete them!

FormCalc SST adds blank lines to the bottom my QuickBooks forms.

The addition of a few blank lines is inevitable because of how FormCalc SST processes the form.
You can minimize the number of blank lines added by keeping the "X" blank Item rows stop
form processing setting at a value of 2 or 3 (3 is the default).

FormCalc SST works fine several times in a row, then the next time it may fail and give
me an error message. If I try it again it works...what's going on?

FormCalc SST is somewhat timing sensitive, and other things "going on" in your computer sys-
tem while FormCalc SST is working can affect it. Even if you have the Keystroke delay set to a
value which work 99% of the time, once in a while FormCalc SST may stop unexpectedly.

Things to try:  increase the Keystroke delay slightly, in Preferences. In some cases, restarting Mi-
crosoft Windows is the only remedy.

FormCalc SST starts working, but then stops somewhere in the middle of my QuickBooks
form.

Do you have too many blank lines in the form's Detail section? FormCalc SST stops processing
when it encounters the number of blank Item lines you've specified for the "X" blank Item rows
stop form processing setting in Preferences.

I have several Actions which show results in the Description column, but the results look all
"jammed together". Can't FormCalc SST put the results on separate lines?
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FormCalc SST is putting some results in the wrong QuickBooks columns.
or...
Some results aren't being shown at all.

Have you changed the form (added or deleted columns, or header or footer fields) since the most
recent snapshot? That can cause FormCalc SST to write results in the wrong locations.
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